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Preface

The impottance of formal education is diversified. The prime goal of modern education
is not to impart knowledge only but to build a prosperous nation by developing skilled
human resources. At the same time, education s the best means of developing a society
free from superstitions and adheres to science and facts. To stand as a developed nation
in the science and technology-driven world of the 21st century, we need to ensure
quality education. A well-planned education is essential for enabling our new
ceneration to face the challenges of the age and to motivate them with the strength of
patriotism, values, and ethics. In this context, the government is determined to ensure
education as per the demand of the age.

Education is the backbone of a nation and a curriculum provides the essence of formal
education. Again. the most important tool for implementing a curriculum is the
textbook. The National Curriculum 2012 has been adopted to achieve the goals of the
National Education Policy 2010. In light of this, the National Curriculum and Textbook
Board (NCTB) has been persistently working on developing, printing, and distributing
quality tex\books. This organization also reviews and revises the curriculum. textbook,
and assessment methods according to needs and realities.

Secondary educalion 15 a vital stage in our education system. This textbook is catered
to the age, aptilude, and endless inquisitiveness of the students at this level, as well as
to achieve the aims and objectives of the curriculum. It is believed that the book written
and meticulously edited by experienced and skilled teachers and experts will be
conducive to a joylul experience for the students. It is hoped that the book will play a
significant role in promoting creative and aesthetic spirits among students along with
subject knowledge and skills,

The education policy has made Information apd Communication Technology
compulsory in all streams of the education from grade VI and XII to introduce the
concepts as in acquiring lileracy in this subject well as to make the students proficient
in information and communication technology. The curriculum and textbooks of this
subject have been developed in accordince with this, Hopefully, the textbook of
Information and Communication Technology for class IX and X will play a significant
role to make stdents interested in this subject along with acquiring literacy
Information and Commumication Technology and creating scope for new jobs.

It may be mentioned here that due to the changing situation in 2024 and as per the
needs the textbook has been reviewed and revised for the academic year 2025, It 15
mentionable here that the last version of the textbook developed according to the
curriculum 2012 has been taken as the basis. Meticulous attention has been paid to the
textbook to make it more learner-friendly and error-free. However, any suggestions for
further improvement of this book will be appreciated.

Finally. I would like to thank all of those who have contributed to the book as writers.
editors, reviewers, illustrators and graphic designers.

October, 2024 Prof. Dr. A K M Reazul Hassan
Chairman
National Curriculum and Textbook Board, Bangladesh
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First Chapter

Information and Communication Technology
and Our Bangladesh
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After completing this chapter, we will be able to —

» explain the significance of ICT;

explain the contributions of the people related with ICT;
gxplain the importance of e-learning in Bangladesh:
explain the necessity of e-governance in Bangladesh;
explain the importance of e-service in Bangladesh;
explain the importance of e-commerce in Bangladesh;
analyse the prospect of ICT in job-sectors in Bangladesh:
explain the role of ICT in social networking;

explain the positive aspects of ICT in entertainment;

explain the future image of an IC'T oriented Bangladesh;
design a poster on an ICT oriented Bangladesh,
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2 Information and Conimunication Technology

The 21st Century and Information and Communication Technolog)y

The concept of wealth that prevailed in the last century has radically changed.
The whole world rightly acknowledges that the wealth of the 21¥ century is
knowledge. It means that neither agriculwire, mineral resources and energy, nor
industry and business are the sources of wealth. Human beings are because they
are capable of searching knowledge. This conceprt has reshaped the people's way
of thinking throughout the world. They have been taking preparations to face the
challenges of the 21st century.

We have already started realising that the world of the 21st century is making its
firm standing on a knowledge-based economy. In this century, two more
important factors - globalisation and internationalisation have come into being.
and 1CT i1s the main driving force behind their acceleration. Now the
geographical border of a country transcends and extends to all parts of the world
as an effect of globalisation. We can refer to Bangladesh as an example to make
the point clear. Millions of Bangladeshis now live all over the world. The place
where they live in is as if a small Bangladesh. So, in one sense, the border of
Bangladesh has extended beyond its own one. Moreover, they, in spite of being
the natives of Bangladesh, are living as the citizens of different countries.
'Internationalism’ 1s the unwritten law of the present world.

Once people had to depend on the blessings of nature for survival. However, by
mventing machines and tools, they have lessened this dependence. With the help
of machines and technology, they have controlled the world economy after the
Industrial Revolution in the 18th and 19th century. The nations. which
participaied in the industrial revolution, once ruled the world. A similar shift of
power has been observed, as the knowledge-based E{:DIIEIID]}" has started
dominating the world in the 21st century.

We can realise that we should take
adequate preparation for taking part in this
revolution. The specific skills for survival
arc the ability to cooperate and
communicate with each other, awareness
about the obligations of the citizenry.
acumen in solving problems, critical

thinking, creativity, and skill in ICT.

ICT Competition
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In fact, skill in ICT has emerged as the most important technological skill.
Everyone should have the basic computer literacy to survive in the 21¥ century,
Only then, one may have access (o ils amazing world. Unless students acquire
the ICT skills, they may not generate new knowledge by collecting. analysing,
and evaluating information. In fact, without the skill. they can never face the
challenges in the 217 century and position themselves in the knowledge based

soclety.

Great ICT Personalities

Many scientists, visionaries and engineers have
contributed significantly to the development of
Information and Communication Technology. Cable
connection and the wireless system, acceleration of

computers' counting power and the development of
microelectronics have ensured rapid growth of ICT.

Charles Babbage (1791-1871). an English engineer
and mathematician, first introduced and developed
computer. He is regarded as the father of the modern
computer. He invented Dilference Engine In 1991, in
the Science Museum of London, an engine was made

according to the design of Babbage. and it worked | "

properly as expected and later, he designed a
calculating machine called Analytical Engine.

Charles Babbage

Ada Lovelace

Ada Lovelace (1815-1852), the daughter ol poet
Lord Byron, first thought about how the process of
calculation could be made more effective. She
became interested in science and mathematics since
her childhood and was encouraged by her mother.
When she met Charles Babbage in 1833, she
brought before him the concept of *programming’ (o
use In his analytical engine. That is why Ada
Lovelace 1is honoured as the pioneer of
programming concept. Babbage delivered a lecture
about his engine in 1840 at Turin University. Then
Ada with the help of Babbage, explained the wayvs
how the engine could work. She marked it in a

3
4
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numerical order, while describing its mode of working. In 1953, when the note
was published again one hundred years afier the death of Ada, the scientist
realised that it was Ada who put forward the idea about the Algorithm of

programming.

Important progress was made in physics during
that period with the inventions of Babbage and
Ada. Scientist James Clerk Maxwell (1831-1879),
combining the electric energy and magnetic force,
put forth the theory of Electromagnetic Force
which opened a possibility of sending wireless
messages from one place to another.

Jagadish Chandra Bose

Bengali  scientist
Jagadish  Chandra
Bose (1858-1937)

But, Italian scientist
Guglielmo Marconi
(1874-1937)
succeeded first in
doing the same work

by radiowave. However, in 1997, the Institute of

Electrical

and Elecuwonic Engineering (IEE)

recognized him as a pioneer and one of the

inventors of radio
science. That is why
he is acknowledged as
the mventor of radio.
In the 20th century, afier

James Clerk Maxwel|

became successful for the first time in sending
wireless messages from one place to another. In
1895, he successfully did it by using microwave.

Guglielmo Marconi

the development of electronics, IBM Company was
the first to build the mainframe computer after the
development of electronics. In 1971, cost-saving
computers were made. With the invention of the
microprocessor, it became easier to make affordable
computers. In the 60s and 70s, using the Internet
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Protocol, Arpanet was invented. The inter connection among the computers
through network started developing since then, and the invention of the intemet
was the outcome. In 1971, American programmer Raymond Samuel Tomlinson
mntroduced the first electronic mail communication through ARPANET. He 1s
the pioneer of inventing the e-mail system.

Steve Jobs

William Henry Gates

In 1989, during the development of the internet, a
British computer scientist proposed and later on
successfully mvented information management by
using Hypertext Transfer Protocol (http). Sir
Timothy John Bernmers Lee 1s known as the |
pioneer of the World Wide Web (WWW). For its
development the Internet technology spread out
throughout the world. A strong economic field has
been created on the Inlernet and different types of
application software have been developed. Timothy John Berners Lee

After the invention of the microprocessor,
personal computer was made by using this
device in the USA. Steve Jobs (1955-2011)
and his two f(riends Steve Wozniak and
Ronald Wayne started a company named
Apple Computer on April 1, 1976, This
company 15 one of the biggest organisations
in the world. The development of the
personal computer has been carnied out by
this company.

IBM company put the responsibility of
developing the operating system for
personal computers on “Microsoft” of William
Henry Gates or Bill Gates (Born on October
26, 1955). They succesfully developed MS
DOS and Windows operating system. At
present, most of the computers of the world
are run by the operating system software of
Microsoft company of Bill Gates.
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The most popular social networking system in the
world is Facebook. A student of Harvard University,
Mark Zuckerberg (Born on May 14, 1984) and his
four friends are the pioneers of creating the social
networking system Facebook. At first, it was used
only by the university students. But now many people
of the world are using Facebook. Many people in our
Bangladesh use Facebook for social networlang
too.

Mark Zuckerberg

E-learning and Bangladesh

For years, knowledge has been acquired across the world in traditional methods.
The innovation and development of [CT have brought about changes for the first
time in these methods. We have become familiar with the terms like e-learning
and Distance Learning. E-learning 1s the short version of electronic leaming
which basically means a teaching process by using CD-ROM, the Internet,
personal network and TV channels. However, we should keep in mind that
e-learning 18 not an alternative to the conventional way ol learning. For example,
it is hard to demonstrate in class different scientific and natural phenomena, such
as, a solar eclipse, a lunar eclipse, and so on. A teacher may demonstrate these
phenomena with images, videos, and graphs with the help of multi-media. The
class can be interactive too.

Bangladesh has a huge population, and that is why the class size is usually big,
The schools in our country lack skilled teachers, teaching and learning materials,
science laboratories, etc. The students do not have a wide scope of doing
scientific experiments. E-learning can play a vital role to solve these problems.
A lesson conducted by a skilled teacher may be recorded and distributed to
hundreds of schools. Different learning materials for teaching a specific subject
can be given lo students. Teachers themselves may make (heir lessons more

effective and these lessons may be reused in other classes. Many terchers of
Bangladesh are using e-learning materials.

Teaching and learning materials are made for e-learning all over the world.
Renowned universities of the world have introduced some online courses and
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anybody can take any of these courses. A learner can take the course either by
submitting his homework or sitting for examination online, and can get the
requisite credit. Research is going on to develop the field.

Bangladesh is not lagging behind in e-learning. The ICT specialists of the
country have opened some web portals offering courses in Bangla, and learners
from any part of the world can take the courses. The ICT oriented, specifically
training courses In computer prograrmming, have earned popularity at home and
abroad.

E-learning can play a vital role in over-coming the limitations of teaching in
Bangladesh. However, it is not a substitute of the conventional teaching method
of a classroom in which teachers and students have lace-to-lace inleractions,
exchange of opinions. and question and answer sessions. Moreover, students can
ask questions, interact, and help themselves in learning something. [n addition,
leachers and students can assist each other in the leaming process and oplimise
their learning by peer-bonding. By contrast, possibilities of interactions are
minimal in e-learning. As e-leaming requires little human participation, it may
become mechanical. Therelore, in order to make e-learning successful, studenis
need to be very pro-active. E-learning has a wide scope in Bangladesh as we can
minimise the lLimitations i classroom teachimg by adopting e-learning.
However, implementation of e-learing practices in classroom will require fast
internet connectivity, necessary infra-structure, and e-learning materials, The
present Government is developing this type of teaching learning materials. It will
help our students to achieve Global standard.

Group Activity

Discuss in group and present how e-learning can play a vital role in the
development of education.

E-Governance and Bangladesh

Transparency and accountability are needed for a good governance. A modern,
transparent., and accountable governance can be ensured by introducing a digital
system, It will ensure good governance, stop the harassment of the citizen, and
pave the way of good governance. The application of electronie or digital
method in the government administration 1s called e-governance.

20325
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Once, it was very difficult for the examinees and their guardians to collect the
result of a public examination. It was even more difficult for the people living in
the remote villages. Even two decades ago they could not collect their resulis a
week after the publication of the result. Now they can get it either through the
internet or the SMS option of the mobile phone. So, the trouble of instantly
collecting the result has come to an end.

Another example of e-governance 1s the facility of submitting applications to the
higher educational institutions with the help of the mobile phone. Previously ifa
candidate of Jessore wanted o apply to Shahjalal University of Science and
Technology, he had to complete a series ol formalities. Candidates or their
representatives had to travel to Sylhet in order to collect and submit university
admission application forms. Now candidates may submit their applications
through mobile phones. They need not to travel from one city to another.

District offices of the Deputy Commissioners have E-service Centres in order to
ensure easy, affordable, and hassle-free services. Now a service delivery of a
services that took 2-3 weeks in the past now takes only 2-5 days. On top of it,
digitalisation of the mformation has reduced the time in decision making by.
Government departments have become transparent and accountable in
providing their services and increased their efficiency in issuing copies of deeds
and settlement records.

The manual process of paying gas, electricity and water bills is time-consuming
and troublesome. Sometimes the busy hours of a day are spent to pay the utility
bills. Now the bills can be paid either online or through cell phones. The target
of the Government is to ensure better lite standards and a hassle-free life for its
citizens, E-governance has made some services accessible 24 hours a day, seven
days a week, 365 days a year. Some of these services, for example, are ATM
services, mobile banking, information services, etc. As a result, citizens may
avail the service at their convenience.

In addition, with the introduction of e-services and inter-departimental
communication, net-working within the Government has increased. Government
emplovees have also become skilled. As a result, providing [aster service has
become easier.
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Bangladesh has introduced e-governance for a few years. E-service is yet to be
introduced to all sectors of the governance. With its successful implementation
n every sector, Bangladesh will certainly ensure good governance.

E-Service and Bangladesh

Many government and non-government AL
service providing organisations provide :‘..,,.,.“....“....._.‘__ e e

L e E S . T e V. 8 M S s A S ST S T By
e ey )

the citizens with temporary and full time i Pt e et et P ity o o P
services. This might be travelling from
one place to another or issuing duplicate
records of a land. Before the introduction
of the digital system. the services seekers
had to meet the service provider, but
now they can receive the services through
the intermet or mobile phones while | SRSl e

staying at home. For example, they | i-oeeieoccoem.

can purchase tickets through the | EEcmmmamimmmen——————
internet. or mobile phone. People, a few | ===

days ago, had to go physically to Kamlapur train station. and stand in the queue
before the counters for tickets. This system is still in practice, but now anyone
can collect tickets and pay the fares online. Providing services through an
electronic system is called e-service. E-service ensures availability of services at
low cost in the shortest possible time without much hassle. E-service has already
been introduced to several ministries, departments and directorates of the
Government of Bangladesh,

b ELAd VA
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The digital edition of textbooks, ¢-settlement records, e-permit. e-ticket,
telemedicine, e-tin registration and income tax calculation, etc. are the
examples of e-services.

A. E-permit: It is one of the primary e-services of the country. The sugar cane
farmers of fifteen sugar-mills of the country get e-permit through the
message option of the cell phone. An e-permit is the official permission of the
sugar mills authority for the farmers to supply sugar canes at a tixed time.
The harassment of the farmers has come to an end as they receive the
information of supplying sugar canes through SMS. The production of the
sugar mills has also been increased due to timely supply of sugar canes.

Forrna-2, 1CT, {9-10)
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Electronic Money Transfer System (MTS): Money can be sent at a low
cost from one place to another quickly and safely through the electronic
money transfer system of the Bangladesh Postal Department. It is possible to
transfer BDT 50000 in one minute. This service is available in all
post-offices in Bangladesh.

. E-settlement Records : The duplicate of land settlement records can be

collected through this service. Previously emplovees of the land settlement
department would supply the information to the applicants from big record
books after filling up the prescribed forms. The applicants had to be present
physically in the office and the employees of the concerned department
waould prepare it manually. Because of the e-service, applicants at home and
abroad can receive the settlement records, paying the required fees.

. E-healthcare: Physicians in government health centres give advice on

mobile phones. That is why government hospitals have been provided with
mobile phones. Any citizen of the country can get the advice of any
physician. Besides. in some hospitals, telemedicine service has been
introduced. Because of the telemedical services, patient in upazila may
avail the service and advice of medical specialists in district hospitals on
mobile phones.

. E-tiketing and Mobile Ticketing of Railway: Tickets of some intercity

trains can be collected either through mobile phone or online. As a result,
travellers can purchase the ticket at their convenience without going to the
ticket counters of the railway station. They can reach the station just before
the departure of the train and collect the printed ticket from a particular
counter.

E-commerce and Bangladesh

There is no substitute for trade and business for the progress and creation of jobs

in

a country. A change has been brought about in the business sector of

Bangladesh for the electronic innovation of digital technology and the internet
and exchanging process besides paper currency. Running a business through an
electronic medium is known as e-commerce.

There are some terms and conditions in business. Firstly, the sellers must have
the commodity. Secondly, the buyers will pay the price of the product. This
transaction requires direct communication of the seller and buyer. However, in
the era of internet, nowadays sellers may create a website and display the

2025
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images of their products. The buyers, afier choosing the commodity, pay the
price and get it. The buyers have the facilities to pay the price through debit
and credit cards. They can pay through mobile banking even. Thirdly, on
receipt of the payment, the sellers either deliver the products themselves or by
the courier. Another payment method is through courier service after receiving
the price.

The bill payment can also be done in the Cash on Delivery (COD) method,
which is different from mobile banking and debit or credit card payment. The
purchaser choose the product from the website of the seller and orders for
supply. The seller after getting the order sends it to the buyer who pays the bill
after receiving it

E-commerce has been gradually increasing in Bangladesh since 2011-12. Now
everything including books, garments, food, luxurious goods, etc. is sold or
bought through e-commerce., Two types of establishments are noticed in
e-commerce like a conventional business. One kind of establishment sells only
its own products and another kind sells the products of different companies. You
have already watched advertisements of some websites on the internet,
television and in the newspaper.

LCT in the Job Sector of Bangladesh

Nowadays, the multifarious use and impact of ICT in the job sector is noticed
in Bangladesh like other countries. The impact and capacity of ICT are
gradually increasing. Two types ol impact of ICT are noticed. First, the
introduction of ICT in the prevailing working sectors has enhanced the skills of
the employees and exiended the market. Second . ICT itself has created new
job-opportunities.

The use of ICT in the prevailing existing job sector and old business sectors, on
the one hand, has enhanced the efficiency, transparency and accountability of the
professional groups; on the other hand, has increased the standard of service.
Skill in ICT is now regarded as the elementary qualification for any job.
Employees of banks, insurance, multinational companies, and government
sectors need to be skilled in word processing, presentation software, internet
browsing, email management. analytical software, etc. In addition, they have to
develop expertise in a specific software product, such as banking software. On
top of 1it, ICT has created a large job market of making hardware, software,
developing websites, maintenance, etc. Now 1t is a big market for the skilled
workers who can work at home or abroad and set up their own ICT firms.
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A major part of the task can be accomplished at home. Many people earn
foreign currency for the country through outsourcing.

Social Networking and 1CT

Social mobility and development require communication amongst individual
human beings. So, social communication means interaction among people
through virtual communication and networking. In other words, what people
create and exchange to communicate and express by using the internet and ICT
is called social networking. Now this communication has become easier.
cost-effective and usually safe. By using the internet, e-mail, mobile phone and
messagig system, blogging and platforms of social networking, the ICT based
social networking has been made easy. Platforms have been set up on the
internet, known as social networking. Such as Facebook, Twitter, LinkedIn, Instagram
gtc. Two most popular social networking websites are Facebook and twitter.

« www.facebook.com: Facebook is a website of the social nerworking svstem.
Mark Zuckerberg along with some of his friends launched this site. Anyone
can be a member of Facebook without any subscription. The users can add
[riends. send messages, update their personal information and give status and
share infermation with others. Besides, audios and videos can be sent through
it. Any organisation can open its home page on Facebook. and at the same
time, like-minded people can lorm a Facebook group. According to
www.stastica.com report of April, 2024 , the number of Facebook usersinthe
world was 3.05 billion.

» www.iwitter.com or X ; Twitter is a social network too, but it has a basic
difference with Facebook. The users have to express themselves and exchange opinions
within 140 characters. That is why it can be called a website of micro
blogging. The message of 140 words is called the 'Tweet'. The tweets of
Twitters are displayed on their profile page. The members of the twitter can
follow other members to read the tweets. Those who follow a member are
called followers.

« www.instagram.com: Instagram is a popular social media platform launched
in 2010 with a focus on photo and video sharing. It allows users to create
stories and search for content via hashtags. It also includes (Reels) and shop-
ping opportunities, through which brands and influencers can effectively
engage with their followers or visitors. It is considered as one of the leading
platforms for digrtal marketing.”

2023
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Entertainment and ICT

With the development of ICT, a new era in the entertainment world has started.
It has occurred in two ways. First, how people consume entertainment has
fundamentally changed. Second, different media of entertainment have
qualitatively changed.

Let us see first how individual media consumption habit has transformed in
response to the changes in ICT. Once, people had to go outside for

entertainment. If they wanted to enjoy a film. they had to go o the cinema hall
to enjoy a [ilm; to the playground to watch a football match: to a concert to listen
to music. Nowadays. there is no need to go outside for entertainment. Radio was
invented first, and then the itelevision. The computer came eventually. The
Internet is the latest addition to the computer. We have discovered that people
can enjoy all kinds of entertainment within the four walls of their home. When
computer firsi came into being, it was only used for computation and
calculaton. Only the big organisations and the government could afford
computers. However, with the development of technology, computers have
become easily available and people have started using them for their personal
purposes. Since computers have become more sophisticated with processors,
huge storage, and considerable memory, they can be used not only for writing or
calculation, but also for entertainment. Perhaps, people use computers mostly
for their entertainment. Composing a song, making a movie. and editing a
photograph - all can be done on computers. Because of the development of 1CT,
changes have come to the media and forms of entertainment. Since songs can be
digitised and converted into MP3 format. they can be played on computers.
Similarly, we can watch videos and movies on computers. A huge volume of
data can be stored on CD or DVD. Watching movies on DVD players without
going to the cinema hall is a very common practice nowadays. Internet with
faster speed has become easily available due to 'fibre optic network'. As a result,
people do not have to depend on audio CD or DVD either for listening to music
or watching films. On top of it, programmes in different radio and television
channels can be directly accessed through the Internet. Sometimes recorded
programmes are also available on the Internet. Hence, viewers can access these
programmes according to their convenience.

New forms of entertainment have appeared with the development of ICT.
Computer games are one of them. Big industries of computer games have been
established all over the world and the experts of these industries are innovating
computer games of various sorts. The extensive popularity of computer games
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demonstrates its immense success as a new medium of entertainment. One of the
reasons for their success is that computer games entertain people of all ages with
different preferences. These games can be played with others. the computer
itself, or even with gamers in a remote place via network. In fact, it should be
noted here that excessive and compulsive use of computer or video games may
become so strong that it can easily turn into an addiction. That is why
people around the world are warned about the negative consequences of
compulsive computer or video gaming. Development in ICT played a vital role
in the emergence of new forms of entertainment. Once, making animation or
cartoon films was very difficult. It has become easier for ICT and high-end/
super computers. Not only that, innovations done by creative designers have
brought about changes to graphic works. Digital actors and actresses have been
created on computers for graphic movies that are no longer dependent on real
actors and actresses. Use of high-end/ super computers in creating imaginary
dinosaurs and aliens for popular commercially successful films is very
common nowadays.

In summary, ICT has not only created new forms of entertainment, but also
made them accessible to the mass. Most importantly, ICT has revolutionised
the entertainment industry and its ultimate future in the entertainment industry
is beyond one's imagination.

Bangladesh has started developing information and communication technology
late in comparison with other countries. That is why Bangladesh 1s significantly
lagging behind. Even though the significance of ICT was not realised, nowadays
ICT 1s getting proper importance. We are getting high speed internet connection
as we are connected to the submarine cable.

There is a positive side of the extension of technology. Il a nation lags behind at
a moment in any particular technology. it does not mean it will stumble all the
time. It may leapfrog other countries. Bangladesh 1s trying her level best to be
equal with other countries in her use of technology.

In the 2024 edition of the ICT Development Index (IDI) formulated by the Internation-
al Telecommunication Union (ITU), Bangladesh scored 62 out of 100. This score is
lower than the average for lower-middle-income countries (64.8) and significantly
below the average for countries in the Asia-Pacific region (77.3). In this index, Myan-
mar, S11 Lanka, Maldives, Vietnam, and Bhutan ranked higher than Bangladesh, while
Pakistan is ranked just below Bangladesh.

2023
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Through e-Governance, transparency in all government activities can be ensured. The
E-Government Development Index (EGII) is used to present the state of e-government
development among the UN member states. Factors such as internet aceess infrastrie-
ture, onhne services, telecommunications connectivily, and people's capacity fo use
ICT are considered. In the 2024 index. Bangladesh ranked 100th out of 193 countries.
In this regard, Bangladesh still has a long way to go in improving its use of ICT.

The infrastructure for information technology has started to be constructed in the
couniry by the preseni govemment. Setting up the fibre optic connection
throughout the country, an initiative is taken to provide the internet service 1o
remote area. The number of telephone users was negligible in the country just
ago one and half decades, but now every adult uses a phone. Information service
centres have been opened at the union level, the post offices of the remote areas
are transformed into e-centres that provide the service of mobile money
transaction. The district information cell and the national information cell with
the union information centres are important additions to the infrastructure of the
country. The tasks like registration of admission test, getting the result of public
examination, and purchasing frain tickets are bemg done regularly on the mobile
phone. ICT courses are included in the curriculum of schools and colleges. This
textbook is an example of that. Computer Science is being taught in the colleges
and universities. The younger generation of the country 1s joming the software
companies along with setting their own [irms. and a large number of young
people are strengthening the economy of the country through outsourcing.

12" May, 2018 is a very important day for us. In this day, Bangladesh, as 57"
state of the world, has launched its own satellite ‘Bangabandhu-1° in the space.
As a result we have moved one step ahead to digital Bangladesh. Bangladesh
will be benefited in the field of Education, Health, Agriculture, weather forecast
and economic advancement by using this satellite. This will be used in satellite
based television services as well as ensuring our National Security. For this
satellite 1t will be easy to spread internet and telecommunication facilities in the
remote areas of the country. By using Bangabandhu-1 Satellite, we will be able
to save and earn foreign currency in the Information and telecommunication
sector.

Activity
Design a poster about what to do for building up 'Digital Bangladesh',
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Exercise

1. In which vear was London Science Museum successful in making the
engine capable of calculating mechanically?

A. 1833 B. 1842

C. 1953 D. 1991
2. Which scientist made it possible for us to do office from home?

A. Charles Babbage B. Ada Lovelace

C. James Clerk Maxwell D. Jagodish Chandra Bose
3. Who 1s the inventor of Facebook?

A. Steve Jobs B. Bill Gates

C. Mark Zuckerberg D. Tim Berners Lee

4. Because of the use of ICT in government services —
1. government services can be easily accessed within the shortest
possible time;
ii. the standard ol government services can be enhanced;

iil. government service can be availed even in holidays;
Which one is correct?

A, 1&i B. id&ii

C. 1 &iil D i, 1 & i
Read the section below, and answer questions 5 & 6:

Shumon fell sick while on a pleasure trip at St. Martin. When he contacted a
doctor in Dhaka, he advised him to get himself admitted soon in a hospital. The
doctor of the nearby hospital arranged his necessary treatment afier consulting
with a medical specialist in Dhaka.

5. The technology through which the local doctor can get advice of a specialist
doctor is—
i. tele-medicine
1. E-healthcare

111, E-commerce
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Which one 1s correct?

A i&ii B. i&iii
C. il &iil D. 1,1 &1l
6. Which technology played a vital role for the treatment of Sumon?
A ICT B. Television
C. Robot D. Computer

7. Milon of Jadurchar, Roumari of Kurigram intends to obtain higher education
staying at home. How can ICT help him?

8. What possibilities have been created by ICT for solving unemployment
problem in Bangladesh? Explain.

Forma-3. [CT-(9-10)
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Second Chapter

Computer Maintenance and Cyber Security
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After completing this chapter, we will be able to —
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explain the importance of computer maintenance;

differentiate between software uninstallation and software deletion:
explainthe cyber risks and information security;

explain the impact of eyber crime on people's lives and what to do if
a victim of a cyber attack;

explain the difference between general and social sites;

analyse the consequence ol the excessive use of the internet;
explain the negative aspects of playing games excessively:

describe the event of sollware piracy;

explain the importance of copyright law:

explain (he necessity of security with reference to the free flow of
mformation in the internet;

expain the importance of troubleshooting in computers;

install and uninstall software following the right process;

prepare a unique password;
troubleshoot the usual problems of the computer.
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Computer Maintenance

A computer combines various electronic components (hardware) and software.
Therelore, to ensure optimal performance, it must be properly maintained. The
computer must be protected [rom external factors such as humidity, temperature,
electrical fields, magnetic fields, dust, smoke, water, etc. Additionally, the operat-
ing system and application software must be kept up to date. Thus, computer
maintenance refers to the efforts to keep the computer in good working condition.

There are two types of computer maintenance:

l. Preventive Maintenance: Preventive maimtenance refers to taking precaution-
ary measures before a faull or issue arises in the computer. Users can perform
this type of maintenance, such as virus scanning, disk cleaning, disk delragmen-
tation, sofrware updates, etc.

2.Corrective Maintenance: Corrective maintenance refers to repairing or replac-
ing components after a fault or issue has occurred in the computer to make it
operational again. Corrective maintenance usually requires the help of & com-
puter technician.

One more important thing to note is that no metallic or magnetic objects should
be kept near the computer. Additionally, to protect against electric shocks, the
computer's power connection should have proper grounding.

Importance of Software in the Maitenance of Computer

Story 1: Raina was very intent on having a laptop from her father after getting
admission to the college. As her attainment in the first term examination was
good, her father bought her a branded laptop with core i5 processor. Raina was
impressed with the quality and speed of the laptop. She installed many pieces of
software within a few days. However. she noticed a gradual decline in its
performance. Aflter one year, she observed that the laptop was running too slow
and it was irksome working on the compurter. Afier some days, she made a
capricious demand to her father for purchasing another one for her.

Story 2: Ankon has recently taken internet connection for the computer. Now he
frequently browses the Web and has benefitted greatly from the sites with the
information related to his study. Besides education. he uses the internet for
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sgnding emails, listgning to music, and watching movie. Recently he has found
the computer often restarting without any prior notification. In addition, the
internet browser opens different sites without any command. One day, he
imserted a memory stick into the USB connection port on his computer. He was
shocked to find out that his files turned into 'shortcuts'. He could not even locate
the original files.

What do you understand {rom the above events? Is il similar to your experience?
You have already known many things about Information and Communication
Technology this time, and you have understood that the processor and software
are the main components in ICT. A new computer, be it a desktop, laptop or
tablet, usually runs fast, but after some days, il gradually slows down. As it gets
old. it becomes slow. Sometimes, you have to wait for a long time after giving a
commmand. Sometimes the situation is so bad that you want to buy a new one.

What is the way to resolve this situation? Here lies the importance of computer
maintenance. You have (o learn a little about computer maintenance in the junior
classes. Most of the people do not like the task of maintaining ICT or
technological devices. However, it is an important task. If you want to keep vour
ICT device operative, you have to maintain it. You need not to be an expert for
that job. We are talking about sofiware-oriented maintenance of ICT devices.

If the Windows Operating System of Microsolt Company is used in your [CT
device (in almost all the computers of the world, Windows Operating System 1s
used), you have to check its status and update the operating system all the time.
If the device is connecled to the internet, the updates are done automatically.
Other operating systems provide a similar kind of facilities too. In spite of that,
you have to use registry clean up software to keep the machine fast. If you do not
use this software, your machine will not work properly and it will be a matter of
annoyance for you,

Besides, whenever the computer is used, some temporary files are created. If
these files are not erased for a long time, they occupy a lot of space in the hard
disk and slow down the speed of the computer. That 1s why we should erase the
temporary files with a software. 1t will make some space free and speed up the
computer.
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Nowadays, the use of ICT device can not be imagined without the internet
connection. Many cookies and temporary internet files are saved in the cash
memory of the intermet browser when vou surf the net. It slows down the
computer. If it is not possible to clean up the cash memory everyday, it must be
done In every few days' mtervals. A piece of software can help you to get the
job done.

Using ICT device without anti-virus, anti-spyware and anti-malware is very
risky. It is an important maintenance activity that protects the users' device from
the attack of virus, malware and spyware, and they can safely use their devices.
Now many anfi-virus, anti-malware, and anu-spyware software can be
downloaded free of cost from the internet and used to protect the computer. Even
these pieces of software can be updated from the internet.

The computer users can run disk clean ups and disk defragmentors © keep the
usual speed of the computer. These programmes are attached with the
operating system. These two pieces of software clean up the space of hardware
and arrange the files in such an order so that the speed of the computer 1s kept

up.
Installation and Uninstallation of Software

We know that the ICT devices are operated with software. These pieces of
software have to be installed in the compuler or in other devices. When we
purchase any [CT device, the seller asks us about the software that we require.
Alter installing the required pieces of software along with operating software, he
gives it to us. In this way, we can use ICT devices, for example, computer, tablet,
smartphone, etc., as we require.

The process of installing operating system software is complex, and expertise
is essential for this task. In addition to the operating system software, we need
different types of software. These pieces of software should be installed on the
basis of our needs.

Installation of any software requires special attention to the 1ssues given below:

» Whether the hardware ol your device supports the pieces of software to be
mstalled;
# Whether there is anything important in 'read me' file: if any, read it;



29 Computer Maintenance and Cyber Security

# Whether all other works are stopped during the installation; if not, the
mstallation process often gets hampered;

# Whether the anti-virus software is turned off, and

# Whether the administrator of the operating sysiem has the permission or not
(Almost all the devices have the permission except some particular ones).

Installation of software, except the operating system one, depends almost on the

operating system itsell. However, the process ol mstallation is almost the same.

We need the soft or the digital copy of the piece of software to install it. It can,
be installed from CD, DVD, pendrive, or the Internet. In most of the cases. a

programme called *Auto Run’ is attached with the software, When you insert a

CD and DVD or connect a pendrive to the USB port, the ‘Auto run’ programme

becomes activated and the piece of software seeks permission to set up. Follow

the next steps afler giving the permission and the piece of sollware will be

installed in your computer. After restarting the device, you will be able to use the

programme.

Uninstallation of Software

Suppose that you do not need to vse the software anymore. What will you do
then? Most of the users keep the software in the hard disk. However, it occupies
a space and creates problem to run the ICT device smoothly. Therefore, it is wise
to uninstall unnecessary software.

How will we uninstall the software? The Operating System Software helps us 1o
get the task done. The nature of all kinds of Operating System Software is almost
same. However, it is easier to uninstall software from a device run by the android
operating system, especially in the touch-screem smartphones. Select the
application from the settings and touch the particular software. A menu will be
viewed on the screen. Click the space where uninstall is written and the piece of
software will be uninstalled.
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The following steps should be followed to uninstall a software from a computer
or an ICT device run by Microsoft Windows Operating System.
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Click the start button and go to the Control Panel. Then double-click the "Add or
Remove' or point to uninstall a programme.
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Click Uninstall of the programme that you want to remove, and uninstallation
will start instantly. If the bulk of the file is large, it may take longer. Usually the
computer needs to be restarted after the unmnstallation of software. Be careful
before uninstalling any software; or else, uninsiallation of a programme may
make it impossible to run the computer without its reinstallation. Therefore. you
must be careful.

Activity _
Following the steps, uninstall a piece of software suggested by
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Deletion of Software

Computer Maintenance and Cyber Security

We know that deleting means erasing something. In fact, by uninstalling a piece
of software, we delete it from our JCT device. What will we do with 'delete’'
command then? A software once installed in the JCT device cannot be
uninstalled completely, unless it is deleted by following the recommended
process. Or else it creates problems. Some parts of the uninstalled programmes
are dumped in the Registry lile of the operaling svstem. However, il is possible
to delete any programme following the steps shown below. We should also be

careful in doing the task,

The steps to be tollowed to delete.

Al first, uninstall the piece of software as per the previous instructions, and

tollow the next steps:

p— Type the name of & program, felder, document, or Internet

recource. and Windows will open it for you.

=

Dpen regedit

TR —

1. Pressing - +1, activate Run command. Write 'regedit’, and press enter.

2. Enter the file. menu.
3 Click Export

ﬂ' Regrtry Editor

3 el i i 5

rﬁ’ Registry Edter

[File] edit View Favorites Help
Imiport...
Export..

Lead Hive

Ustlpad Heee..

Conpect Network Regastiy...

Dezcormmct Networi Regntry..
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4. The drive that contains the operating software, that 1s C . should be selected.
g Bepen rpintty fom T ——
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5. Save the file. It is very important. If any error is made, the system may be
repaired.
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6. Enter 'Edit' then.
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7. Point 1o "Find’.

Fomma-4, ICT-(9-10)
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8. Find out the name of the software to be deleted, for example, ADUIALS.
9. Click Find Next .
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10.  Select in this way.
11. Pressing the right button of the mouse, click the Delete’ option.
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12. Finally press ‘F3’ of the keyboard and delete all the files having that name
from the Registry. In this way, the entire process of deleting will be
completed.

Group Activity

Comparing uninstallation and deletion, present it.

Information Security and Cyber Risk

Information has become one of the most valuable resources today. There are two
main types of access: open information and confidential information. Open data
is freelv accessible to everyone and can be shared without restrictions. Examples
include news, articles, and press releases from organizations or mstitutions. It is
made for public use and does not require any complex security. On the other
hand, confidential information is restricted to authorized individuals or organiza-
tions and is protected by legal obligations. For example, commercial contracs,
national idf:]lTil}‘ cards, passwords, etc. Disclosure of confidential information
without permission may result in legal complications or financial compensation.
Forma-4, |CT- 810



27

In the age of the Fourth Industrial Revolution, digital technology has become
essential for sharmg personal information to meet varous needs. Digital tech-
nology refers to electronic devices, systems, and tools capable of processing,
storing. and transmitting data in binary forni, enabling tasks like communica-
tion, accounting, and automation. However, with the widespread adoption of
these technologies, individuals are increasingly exposed to cybercrimes that
jeopardize their information security. The cyber-world 1s a digital space where
people interact and access information via the internet—a virtual realm built on
data, code, and the web. This parallel world continues 1o expand and evolve,
becoming an integral part of our daily lives.

Cyber Crime

Any action that violates societal norms or the law is considered a crime. When
such actions are carried out online or using the Internet, they are called cyber-
crimes, These crimes invelve using computers, digital devices. and the Internet,
and sometimes the devices or networks become targets of cyberattacks. Cyber-
criminals can steal personal information, putting individuals® safety at risk.
Therefore. everyone must understand how to protect themselves from cyber-
crimes and information security threats in the digital world. Cybercrimes come
in various forms, each posing unique risks to information security. Some exam-
ples of cybercrimes are listed below.

. Hacking

. Brute Force Altack

. Data Interruption

. DDoS Attack

. Computer Malware etc.

Hacking
Hacking is usually accessing or taking complete control of a website or comput-
er network without permission. The person who hacksis called the hacker.
Hacking can be legal or illegal. Some organizations hire hackers to test the secu-
rity of their systems. The work of these hired hackers is called legitimate hack-
ing. They check system security but do not harm the system.

For example, there are many legitimate hackers to
check the system. They are called white hat hackers.
Those who do illegal hacking are also called Crackers.
Nlegal hackers or crackers use the Internet and other
networks to steal or destroy data. They uvsually use
several techniques to easily find out the vulnerabilities
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of software systems over the Internet and find passwords.As a result, it can
easily cause damage. They are called black hat hackers. The trend of hacking
crime is mcreasing day by day. Cybercrime is committed through hacking.
Hackers can view other people's e-mails, gain unauthorized access 10 web serv-
ers, or steal files over a network.

Brute Force Attack

Just as a thief in real life uses different keys to enter a locked room and try to
unlock it. digital eriminals use other types of software to illegally access peo-
ple's accounts such as bank, social media, and email accounts, and in many cases
even digital devices. And try to make assumptions about them one by one.
Sometimes, they are successful, and if successful, they steal various personal
information of the person.

Brute Force Attacks

S e —
- q ~ Automated Tool

They use the stolen personal information to commit multiple crimes. This type of
cyber attack is a severe cybercrime.This type of cyber attack i1s known as a brute
force attack. It is @ method in which an attacker systematically tries all possible
combinations of passwords or encryption keys to gain unauthorized access to a
system. It relies on (rial and error, using aulomated tools to find each option
correcily and keep trying until it succeeds. This can be effective if there are no
security measures such as strong passwords or other measures to prevent this.

Data Interception

Water pumps usually irrigate land for agriculture to the land or fields through
drains or pipes. If someone cuts this drain or pipe midway or leaks the water
pipe, then the amount of water that 1s supposed to be received will not be avail-
able. As a result. farmers will suffer. A vigilance system should ensure that no
one can illegally take water in the middle. Similarly, when exchanging informa-
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iion digitally, someone beiween the receiver and the sender can intercept it. This
process of thefl is known as data interception.
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End-to-end encryption. commonly used in software or apps, ensures that data
(such as messages, images, videos, voice call records, and documents) cannot
be intercepted or stolen by third parties. Encryption is the process ol encoding
information to prevent unauthorized individuals from reading or understanding
it. As a result, the data becomes unreadable to anyone without proper authoriza-
tion. Confidential information transmitted over public networks is typically
encrypted with a unique code to safeguard its privacy and security.

DDoS Attack - (Distributed Denial of Service)

When a person 1s interviewed on TV, if many people ask the person many ques-
lions at once, it becomes diflicult for the person to speak well on a particular
topic and wastes time. Because he can lose track of what o say and what to
keep. Similarly, in the digital world, a Distributed Denial of Service (DDaS)
attack uses multiple devices to attack a specific target simultaneously.

Aftackers
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Internet
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In a DDOS attack, multiple computers or devices flood a website or online
service with traffic, slowing it down or causing it to crash. The attack aims to
impersonate the system so genuine users cannot access or use it
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Malware

Malware 18 an abbreviation for English MaliciousSoftware. Malware is soliware
designed and developed to intentionally harm a mobile. computer,server, web-
site, or computer network. This softwareworks against the interests of the user
of mobile, computer, or any other digital system. However, if a piece of software
unintentionally causes a problem to a computer system due to its incompetence,
it cannot be called malware; This is called a software bug . Malware is a type of
harmlul soltware that is used to disrupt the normal [unctioning of a computer,
mobile, or any other digital system, collect confidential information, illegally
intrude into a protected computer network system or display unwanted adver-
tisements. Malware can be of different types. Namely - Computer viruses,
Worms, Trojan Horse, Spyware, Ransomware, Adware, Rootlats, Spamming
elc.

Cyber Bullying

Forcing a person to do something through the use of mformation and communi-
cation technology is called cyberbullying or cyberterrorism. Humiliating some-
one socially, making threats, creating fear, publishing someone's personal infor-
mation or pictures on social media without permission,publishing wrong infor-
mation or spreading rumors about various sensitive issues on social media,
creating chaos in society, or spreading communal hawed. Nothing includes
cyber terrorism.

Mobiles, computers, tablets, devices, social media, websiles, messages, e-mails,
etc.. are used for cyber terrorism. A person is socially humiliated, and their
private life is disrupted by embarrassing pictures, videos, and offensive or
insulting comments in e-mail or social media,

Cyber terrorism is more common among children, teenagers and young adults.
As a result of this, their social and family life is affected, as well as feelings of
inferiority, depression, panie, and even suicidal tendencies are created in them.
In most cases, deleting an 1mage, video, or information is very difficult or
impossible after publishing it on social media or a website. Again, in the case of
a fake ID, it becomes very dilficult or impossible to find the identity of its source
or publisher. So we also have to be careful about these things.

Fake News
Fake news is any false or misleading information presented as news that is inten-
tionally spread to deceive people or influence people's opinions. It can be fabri-
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cated entirely of stories or distorted information and used to mislead the public
or promote a particular agenda through social media, websites, or other chan-
nels.

In this age of overuse of social media, the spread of fake news is happening at
an alarming rate. Fake news spread over the internet has led to many political
and religious conflicts around the world. The news that 'Chile has taken the ear'
should not run after Chile, but first of all should look at the ear. Similarly. any
online post or news should be verified and believed. Various types of {alse news
or rumors are usually spread using fake names of individuals or organizations.
According to the Information and Technology Act 2006 in Bangladesh, cyber-
bullying and spreading fake news on digital platforms is punishable by impris-
onment of up to 10 years or a fine of up to Tk 1 crore or imprisonment and fine.

The lollowing tasks can be done il anyone becomes a victim ol a Cyber Attack.
For example:
1. Contact National Helpline 109, National Emergency Service 999 or ICT
2. Helpline as soon as possible.
3. Assistance can be sought from someone proficient in technology.
Complaints can be liled on the website of the www.rab.gov.bd.
4, Ti should be shared with parents or the members of the family.
5. The digital devices need to be turned off.
6. A written complaint should be submitted to the Bangladesh Telecommuni-
cation Regulatory Comission (BTRC)
This issue should not be shared with strangers or discolsed publicly.
A general diary should filed to the neares Police branch.
. Concusmer's rights need to be practised.
ﬂ' Evidence of the crime should be collected.

I—\SDC'“-J
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Il we fall victim to such incidents, we will not keep it to ourselves but inform our
parents and even teachers and we will quickly make a General Diary (GD) at the
nearest police station. In our country now GD or general diary can be done
online. For this, we must search by typing: https://gd.police gov.bd in the address
bar of any internet browser.

Mobile application software (apps) lor almost all units of law enlorcement agen-
cies such as Rapid Action Batialion (RAB). Counter Terrorism Unit (CTU),
Criminal Investigation Department (CID), and Metropolitan Police such as
Jawadhaar Jai, Oibhashad Inadhaar. ete. Playstore By downloading from and
keeping it on your mobile phone, you can use it to fight crime even in times of
danger. Suppose someone has sulfered an accident in the cyber world. In that
case, they should send a GD to the nearest police station along with a copy of the
GD and the following information along with the information about the crime in
the application of Jabrat Jai or contact the cybercrime helpdesk of the nearest
police station with a copy of the GD.

The Strategies for Security over the Internet
The following security strategies can be used for safe Infernet use and (o protect
personal information and devices from online threats. namely-
= Enable Two Factor Authentication {2FA).
* Using strong passwords and not using the same password across all digital
platforms.
= Updating computer soltware and mobile application software (general)
regularly,
» Refrain from sharing private or confidential information on social media.
» Not to share personal confidential information (pin code or password) with
anyone.
= Installing antivirus and lirewall protection on the device.

Two Factor Authentication (2FA)

Two-factor authentication means that when we log in with the ID and password
to access our e-mail, social media, or other online accounts, an OTP (One Time
Password, which 15 six digits long) comes to our phone or mail. We can access
the account only when we give that OTP correctly; otherwise, we cannot.Items
shipped for a limited time. Once used, the token expires and the same token
cannol be used again. Having enabled two-factor authentication makes it very
difficult for eybercriminals to hack an account.
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Nowadays, social media is very common. We use social media tor various purpos-
es and enlerfainment. However, we must be very careful about what personal
information we share on social media and what we don't. Hackers can steal our
money through social engineering through various content uploaded on our social
media. We have to be aware of this.

In the practical class, the teacher will show the students the steps to imple-
ment Two Factor Authentication (2FA).

Internet Addjetjon Dysorder (1AD)

The word ‘addiction’ has negative “

connotations and it is usually used with ‘8

reference to drugs. It destroys life because it >\
) )

is tough to come out of the web of drugs. .

Perhaps you are confused thinking that how / /=
an alarming and negative word ‘addiction’ )
can be associated with ICT and mentioned in
an [CT textbook. Some of you who have
computers may have crossed the limit while
playing computer games. A few of you did
not leave the computer even though you
should have for an important task. The users who have the internet access have
Facebook accounts too. When you post status on the Facebook, you eagerly wait
for a long time to see whether somebody gives a Like' to yvour status. You feel
pleasure when the number of your Facebook frnends increases. Perhaps vou may
have spent more time on Facebook than usual. You might have done better in the
examination if you had spent less time on this social network. You could have

read some good books or played a bit more outside in the playeround or spent
more time with your family members.

Perhaps you, who have been damagmg vour lives by wasting your time on
Facebook or by playing computer games more than you should understand the
cause ol adding a negative word *addiction” with the positive words ‘Computer’
and the ‘Internet’. *Addiction’ means when someone. in spite of knowing it is a
freakish act, cannot resist the temptation of doing it. What is true for drugs is true
for the computer and Internet too. As drugs are harmful for life, so are the
computer and the internet il they are used beyond the limit.

Forma-5, ICT-(2-10)
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Addiction to Computer Games

An addiction to computer games begins from the
childhood, and it usually happens due to the
ignorance of parents. A computer is a tool and
different types of work can be done with it. As
many positive words are said ol this technology,
parents think that what is done through a computer
is positive. Therefore, when they see their children
sitting at the computer for a long time, they do not
think of being alert. Computer games are a kind of
entertainment, and it has a different dimension. If you play computer games
merely as entertainment while staying within the limit, that can be a part of good
entertainment, However this does not happen most of the time. People across
age, children to adults, may be addicted to computer game. A Korean man died
while playing a computer game for 50 hours at a siretch. A Chinese couple sold
their child to pay for their computer games. These examples remind us that an
addiction to computer games is not unusual. [f caution is not taken, one can
easily be addicted to computer game.

As addiction to computer games is new, extensive research has not been done on
it. In future, it will provide us with absolute direction. Research has identified
the presence of a stimulating chemical in a gamer's brain, addicted to computer

games. The shape of a brain 1s altered in those who use a computer 10 hours at a
stretch 6 days a week,

Therefore, we should keep in mind that computer games could be a good
entertainment, but it is very easy to get addicted to it, and the effect of it is
cerfainly damaging.

Addiction to Social Networking Site

Man 1s a social being. They continugd a social relationship all the time.
However, the nature of social communication nowadays is distinctly different
from the one in past. It means a different social networking based on the internet.
There are some social networking sites such as Facebook, twitter, instagram,
LinkedIn. Tiktok, Likee ete. through which people can communicate with their
circle. Once, these sites were only for the young people. but now people of all
ages use it. They use it not for communicating with others, but also for establishing
ideologies and legitimising their opinions. If it was within the periphery of
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objectives, it would not have created any problems, but it is a malter of regret
that addiction to social networking sites has becomes a problem for the whole
world.

The psychiatrists have started doing research on this matter, and the findings
show that the success of the sites depends on how skillfully they can attract the
users. The main factor is how often users visit the site and how long they remain
on the site. The more the sile is visiled, the more successful the site 1s and
consequently, the more money the site will earn. Therefore, if the users are not
careful, there is every possibility of developing addiction to these sites.

Another interesting factor was identified by the psychiatrists. Individuals have
an inherent desire to impress and admire their own self. In psychology, this is
defined as 'narcissism’. The social networking sites instigate this inherent hurman
desire. A competilive attilude develops within everyone o make themselves
popular. The users upload minute information about themselves, and when
people watch and like it, they become happy. The entire system works like a
drug, and users waste their time for hours. In [act, a major wasie of ime
world-wide is caused by the immense popularity of social networking sites.

The Way out of Addiction

We have already learned in the previous section that a man can be addicted to
computer games and social networking sites just as he can be addicted to drugs.

Therefore, both drug and computer game or social networking site addicts
display a similar kind of signs and syniptoms. It is wise to be careful than to try
to get rid of the addiction. There is an apprehension that the users who do not
know anything about the addiction may develop a tendency to it. Since you have

read about it in the textbook, you may remain more careful about it.
People may become too preoccupied with it, as they do with other sources of

entertainment. However, playing computer games does nol increase our
knowledge on technology. You will just have the enjoyment of playing the
computer games, not any technological knowledge. You should be careful about
playing computer games, so that it may not affect the important works of your
daily life.
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We hope that you will not be addicted to
computer games. Similiarly vou will prevent
the people around you from being computer
game-addicts. Those  who  become
game-addicts  show  some  particular
symptoms. They always think about a | =
particular game, and when they start playing | &
the game, they become excited, and they can |

not do their daily jobs smoothly. They become —
inattentive in their studies. When they are | T :
forced to keep themselves alool from playing OGN P
games, they feel discomfort. The point of worry is that the addn:tmn may come
back even after they become free from this bad habit. The people, who somehow
have developed addiction to computer games and wani to get rid of ii, have to
acknowledge themselves the fact that they have developed an addiction. They
have to make a list of the important events of their life. They should convince
themselves about the place of computer game on the list. They have 10 make a
list of the problems of their life too, and they should identify the problems
caused by playing computer games. They should divide and allocate their time
to cover all the importani aspects of life-study, homework, playground,
extra-curricular activities, spending time with the family, and voluntary social
works. If they get spare time afier doing all of these works, they will play
computer games. They should gradually keep themselves busy with ereative
activities rather than computer games.

The users who have been addicted to social networkang sites should proceed in
the same way to get rid of the addiction. They should try to convince themselves
that wasting time on these websites is a kind of addiction. When vou have an
intention of watching something on social networking sites, you should ask
voursell whether vou have really any purpose of watching it. I[ not. you have
to control yourself. You should note down the duration of ime you spend every
time on the sites. After summing up the time you spend on 1t in a day, week,
and month, vou should come to a conclusion about the volume of work you
could have done during this time.



Information and Communication Technology 37

You have to reduce the number of unknown friends from your social networking
site to reduce vour addiction. You have to convince yourself that you can surf the
sites alier completing the important jobs. You have lo develop the habit of
deactivating social networking sites when you have exams or other important
events. You will gradually reduce the addiction in this way, and finaly get rid of
it completely.

You should remember that every moment of vour life is valuable, and it is
unwise to spend these moments for any addiction.

Piracy

The objective of copyright law is to provide the writers, artists, and others with
the exclusive right to their creative work. Usually it is expensive and difficult to
reprint any book by violating the copyright law, but now it i1s easy to make
‘copy” or ‘facsimile’ using computer technology. It is not required to be an
expert for doing the job. Therefore additional measures are taken to protect the
copyright of computer software, graphics, and animation. When the legal right
15 violated, they are deprived of their copyright. It is usually called ‘Piracy’ or
*Sofltware Piracy’.

The concerned entrepreneurs, writers or programmers can preserve the right to
their intellectual property within the purview of copyright law. That is why it is
illegal either to copy or create something new by editing the software without
the consent of the copyright holders. Therefore, the copy or the new creation has
no legal protection. Even though it is easy to pirate computer software, the
malpractice is not very frequent in the world. The renowned software companies
have formed an agency named “Business Software Alliance’” (BSA) to preserve
their copyright and to monitor piracy worldwide, The statement given by the
agency in 2011 shows that 7 out of 10 computer users are free from piracy. As

software piracy is an easy task, it is difficult to get the right statistics. Software
piracy is strictly prohibited in Bangladesh.

The Urgency of Copyright Law

The copyright law ensures the right or ownership of the creators to his works for
a certain time. If the creation has any commercial value, the creator should get
it. As poets, litterateur, movie producers, software writers, web designers all
require money and web designers earn thewr living from creative work, they
mmvest labour, intellect, and money in it. They invest money for their labour and
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meril of creative works. Therefore, they should have the right to get their money
back either by selling or exchanging the products. The legal right within the
purview of copyright law has given them the advantages. Artists or
programmers get disappointed if they fail to gain any financial benefits for their
creative or intellectual properties. The implementation of copyright law will
save the creative workers from being deprived.

Right to Information and Seecurity

The law of 'Right to Information' is enacted and implemented in different
countries of the world to ensure the free low of mformation and people's right
to have information. the Freedom of thought, conscience, speech’ right to obtain
mformation has been assented as the fundamental night of the citizens in the
constitution of the People's Republic of Bangladesh. As all powers in the
Republic belong to the people, a law called 'Right to Information Act-2009" has
been enacted to ensure the right of having information. Every citizen has the
right to get information from any authority whenever it is sought under the act,
and the concerned authority is compelled to provide the information if asked. If
people’s right to information 1s ensured through this act, the transperancy and
accountability of the government. autonomous, statutory organizations, and
NGOs funded by the government and foreign organmisations will be increased,
corruption will be reduced, and good governance will be established. The right
to information has been ensured under the Act and directives have been given to
the organisations to preserve information.

The Act has ensured access to mmportant information of the state. The
accessibility of government-held information Is an Important part of
government transparency and accountability to its citizens and good
governance. However, seeking and receiving information that may jeopardise
the security of the state is not permissible in the Act. For example, the Act
does not allow access to questions before the public examinations because the
exam processes will become controversial. The secrecy of question papers 18
secured through ‘Right to Information Act’. If technical, technological, or
scientific information is leaked out. the organisations stand to lose financially. In
this context, keeping the information secret is not the violation of the rule, The
most important factor is that any information that may pose a threat to the
security, unity and sovereignty of the state is not obligatory to reveal under this
Act.
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General Troubleshooting

It is unusual that electronic devices have not gone out of order or not created
troubles during using. Some problems are very usual, and some are unusual and
complicated. Usual problems can be fixed by the users, but they have to take the
help of experienced people for complicated problems. Computers or ICT
devices are not exceplions. Those who use electronic devices have noticed that
an operating manual is given with every device. The manual contains a section
on the last two or three pages, entitled, 'trouble shooimg'.

Troubleshooting is the process ol finding out the source of troubles. Usually
some questions are given with solutions. The users, according to the nature of
problems, solve them [ollowing the solutions.

In fact, trouble-shooting is a systematic process of identifying the source of
problem in the ICT devices in order to solve it. In the manual, usually some
possible problems and solutions in relation to the ICT device are mentioned.
The users. following the basic trouble-shooting steps given in the manual. can
usually resolve the problem in most of the cases. Usually the word
'Troubleshooting' 1s used for hardware rtelated problems. Some
troubleshootings are discussed 1in the next page
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Some Common Desktop Computer Problems and Solutions

Sl nos. Problems General Solutions
1. Computerisnot | 1. Check the main power cable whether the
) connection is loose or not.
starting up. 2. Check whether there is pawer on the main power-board.
3. If there is no power on the main power-board,
change the main power supply unit.
4. Take the device to the local service centre and
consult an expert.
5 | Nothingis 1 Check if the monitor light is on. Tf the light is on, check the!
’ viewed on the monitor data cable and plug it properly if the cable is open or
monitor loose.
though the 2. Turn off the system and unplug the power cable
syster s from tha main system.
. 3. Remove the RAM from the slots.
Sl 4. Clean up the connectors of the RAM rubbing
with an eraser.
5. Clean up the slot of the RAM with a hard brush.
6. Turn on the computer without installing the RAM,
and notice whether you get any beep sound.
7. If you get any beep sound, turn off the computer,
and again turn on after installing the RAM.
8. If you get any beep sound, you have to understand
that the RAM is faulty.
9. Install a new RAM if there is no display yet.
10 Install the RAM, and check again. Faulty RAM is the
| reason for at least half of the display problems.
3. | The system 1. Openthe Casing.
becomesvery | 2. Remove the CPU or processor fan from the
heated, and motherboard, but don't remove the processor.
abruptly shuts | 3. Perhaps the heat sink is filled with dust that creates
down. olegobstruction on the free flow of air. As a result, CPU

o

4,

can not be

Clean up the heat sink and fan, and install again.
Now, after closing the cabinet, turn on the computer
again.

If the problem is not solved, take the computerto a
service centre, and talk to an experienced
mechanic,
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Sl nos.

Problems

General Solutions

4.

The computer
shuts shown on
its own at every
few minutes,

Check the mother board carefully and find out if
there 15 any leaking or faulty capacitor has got
loosened. Tighten the capacitor and the problem will
be resolved.

but 1tis not 2. Notice very carefully as the computer 15 Tunning

heated, whether any IC or any other component producing
gxtra heat. Be cautious. Let not the board be shorted.
If 1t happens, go to the nearest service centre.

3 The device 1. Check whether there is any virus in the hard disk by
freezes running an upgraded anti-virus.

Whihj: 2. Taking the back up of important data from the disk,
running the format € drive, and reinstall Windows. Tt should
Windows.

be done by an expert.

6. Display freezes |1. 1st Step: Turning off the power button and
when the opening the caching, carefully remove the
power button is data-cables and power-cables connected to hard
turned on,

disk, CD-ROM, and DVD, and after reconnecting
the cables, restart the computer.

2nd Step: Check RAM, processor, power supply
connection separately whether they are faulty or
loosely connected.

3rd Step: Check the motherboard using the
processor, RAM Hard disk and other related
equipments from an active computer. If it is not
active, change the motherboard. Get the job done
by an expert hand or taking the computer to a
service centre,

Note: Sometimes this problem persists when the

keyboard and the mouseport of the motherboard
are loosely connected. Set the connection
propetly.

Forma-6, ICT-(9-10)
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Slnos.| Problems General Solutions

9. The computer If the cooling fan set over the CPU does not move
repeatedly or cool the system properly, this promlem occurs.
freezes, and In that case, switch off the power, and opening the
reboots cooling fan, check it out. If the fan is faulty, replace
automatically. it. Besides, check the fan behind the CPU while the

computer is running.

The problerm persists if the computer has any virus.
Clean up every drive of the hard disk by running
an updated anti-virus. Besides, it happens due to
the installation of new hardware or programme. In
that case, uninstall the programme and run the
computer.

8. S;Et‘:rr:? an If you get electric shock by touching the metal part of
shock when the computer, it is certain that the computer has
}"‘ﬂl-;tFUCrf_\tﬂ}E not earthed. Calling a skilled electrician, get the
metal part o
the cﬂﬁwputer, computer properly earthed.

2. The date of the Iif the CMOS (Complementary metal-oxide
E{?#;Etﬁl;%ﬁ}s}lggd: semiconductor) battery of the motherboard loses
all the time nfr if power, this problem occurs. In that case, set a new
any option o
th é" BIOS is CMOS battery on the motherboard.
changed, itI is
not proper
savee:l. A

a Switching off the power, open the caching, and

10. | Showing ,the check the data cable connected tomotherboard and
message B:.:}D‘t hard disk drive, and check the connecting point of
Disk failure' or the power cable from power supply unit to hard
'Hard disk not disk and properly connectit.
found: Set the jumper properly following the jumper

setting diagram on the back of the hard disk.
Entering the BIOS, check whether the hard disk is
detected from the options of the BIOS either
manually or automatically. If the problem is not
resolved, connect your hard disk to a sound
computer and check whether it works or not. If the
problem persists, buy a new hard disk and install
the programmes you require. Get the job done by
an expert.
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Slnos.| Problems General Solutions

11. | Showing 1. Usually these messages are shown when you install
messages like excess programmes, and work keeping a lot of
'Out of programmes open.
memory' or 2. If the computer does nat have sufficient memory
‘Mot enough for installing excess programmes, this problem
Memory, occurs. Additinal RAM can be installed in the

motherboard to resolve the problems.

12. | The keyboard is | 1+ Shut down the computer, and check whether the
not warking. keyboard is properly connected to the port.

2. If itis not properly connected or the connection is
found loose, refix it and turn on the computer
again.

3. Clean up the virus by running an anti-virus software.

4, If the problem is not fixed vet, install a new
keyboard.

13. | The mouse is 1. Check the connecting-cable of the mouse to the
not detecting computer,
anything. Change the port to see whether it works.

3. Connecting a new mouse to the port, check it
again.

4. Entering the BIOS check whether the mouse is
disabled. If so, enable it, and come out of the BIOS.

5. If the problem persists, connect a new mouse to
the computer. The problem will be resolved.

14. | No power is 1. Besurewhether the power button is turned on.
viewedonthe |5 chack the AC power cord connected properly to
manitor.

the power outlet behind the monitor.
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Sinos.| Problems General Solutions

15. | Thepowerof |1. Check the video cable whether it is properly

the monitor is connected to the computer or not. If the other
viewed on, but point of the video cable is not permanently
there is no connected to the monitor, fix it firm.

display on the |

: Adjust the Brightness and Contrast.
monitor,

1. Check to see if the correct model of printer is

16. | The printer is
selected.

not giving any
printing output. | 2. Check the power cable connected to the printer.
3. Check whether the button of the printer is turned on.

4. Check if the data cable of the printer connected
properly to the computer.

5. Opening the cover of the printer, find out whether
any paper Is jammed inside the machine.

6. Check whether the cartridge contains any ink.
Remove the cartridge, and fix again after shaking
it well.

7. If red or yellow blinking light is shown, press the
reset button of the printer.

g. If the problem is not resolved, install the driver
sofware supplied with the printer.

g. Consultan experienced hardware expert.

Group Activity
Discuss what other problems a computer may have besides the ones listed
above. Identify some solutions to these problems.

2023

Exercise
1. What happens when you have many temporary files?
A. Computer runs slow. B. Computer runs fast.
C. Antivirus does not work. D. Internet access is denied.
2. Which programme runs fast while installing a piece of Software from CD,
DVD or pendrive?
A, Setup B. Autorun

C. Read me D. Restart
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3. Which one is the resource of the modern world?

A, Information B. Data
C. Computer D. Internet

4. Installation of software requires attention on whether —
1. it supports the hardware or not.
1. the antivirus software is closed or not.
iii. it has the permission of the administrator or not.
Which one is correct?
A& B. i&ii
C. i & i D. i1 & iii
Read the section below, and answer the question numbers 5 & 6:

Mr. Ekram has been noticing for a few days that his computer restarts after being
shut down at irregular intervals. He remembers that it started happening after he
copied a song from the pendrive of his friend a few days ago.

5. The error responsible for the computer might be?
A. Operating System Software  B. Virus Software
C. Utility Software D. Antivirus Software

6. For this reason, the computer of Mr. Ekram —
1. may show an unexpected message.
il. may increase the size of files.
iii. may show that it has insufficient memory.
Which one is correct?
A 1&i B. i&ii
C. n&i D. i, 11 & iii
7. One of your friends play computer games frequently. What negative impact
may this have on him? Discuss.

8. Tt is very important to know about the troubleshooting of computer—
Explain the staternent with your arguments.
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Third Chapter

Internet and Introduction of Web

After completing this chapter, we will be able to—

explain the concept of digital content;

YW

explain the significance of the Infernet in education:
identify the fields of using Internet in an academic curmiculum;

explain the importance of ICT in career development;

b A A

make a presentation on a related topic with the help of Internet.
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Internet

We have already learned that the Internet is a global network that connects com-
pulers and devices around the world. It 1s used to enable people or devices to
share information and communicate with each other via wire or wireless. It is
also used to browse websites, send emails or chat with friends. It uses digital
conlent,

Digital Content

If any content is preserved, expressed or exchanged as digital data, that is digital
content. [lowever, it can be preserved erther in a digital or in an analogue
system. Digital contents can be exchanged either as files of the computer or of
the digital system. Written information, images, sounds or videos anything could
be digital contents.

Types of Digital Content

Any information, image, sound or everything expressed through a digital media
1s digital content though it can be divided into four major categories:

* Text or written content;

+ Image;

» Sound or audio and

* Video and animation.

Text or written content: The written content 15 still voluminous in digital
media. It includes all kinds of written information, such as essays, blogposts,
list of commodiiies and citizen's charter, prices of commodifies, e-paper,
reports, ete.

Image: All kinds of pictures. photographs, sketches, and computer images such
as illustrations, cartoons, info-graphics, or animated pictures are the conients of
this sort.

Sound or audio: All the contents of sound or audio are included in this
content. Any kind of audio file along with the broadcast on the Internet and
webinar are audio content.

Video and animation: Any kind of video and animation is its content. The
volume of video content is increasing dav by day, as nowadays mobile phones
also have the ability to record video. Similarly, the volume of video content in
the Internet is gradually increasing for the video sharing site like youtube,
Besides, direct airplay of some events is very [requent on the Internet. It is
called "Video Streaming' which 18 also regarded as a video conlent.
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book

E-book or electronic book is the electronic format of the printed book. As it is
published through an electronic medium, sound, animation, etc. can easily be
added to 1. These books can only be read either by using compuier or e-book
reader. Kindle of Amazon.com is the most popular of all e-book readers.
Benefits of Using E-book

X:
2.

T

o

[nformation may be accessed instantly by downloading e-books.

E-books do not require any library or specific space for storage. They can
easily be saved and stored on a computer or in a reading device.

E-books are easily transferrable.

It is easy to find out information in e-books.

As e-books can be purchased through Internet, they do not incur any
shipping or packaging costs.

E-books are gasy to distribute and sell.

E-books can be printed out according to individual demand, and hence, they
are financially more viable.

Different types of E-book

Nowadays, different kinds of e-book can be found. Different publication
requires different e-book tormat. Usually e-books are divided into the following
five categories:

Exact copy of a printed version: These books are like their printed versions.
They are published in the pdf (portable document format) lormat. The
complete texts or parts are available on the internet.

E-books that are only readable on the internet: These books are vsually
published in the HTML. This is called the website of books.

E-books like printed version with some additional facilities: In these books,
the readers have the facilities to comment and to know word meaning. Most
of the books are published in (EPUB) format. These books are possible to
read by using a special device, for example, ibooks and kindle reader, but
the kindle and ibook reader have their own compatible format.

Smart e-book: Audio, video. animation, ele. are included in these books
along with the written part. These books are called smart-e-books. Its content
18 enriched with interactive multimedia features. For example, there are
quizzes, spaces to answer the quizzes. and options to check the answers. 2D
images are added to these e-books. However, some e-books are formatied in
such a way that they can be accessed with a specific electronjc device and
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hardware. For example. 1thools created by Apple computers can only be read
with an ipad or mac computer.

*  Apps of e-book: The e-book itself is published as an app on the computer or
on the mobile phone. The e-book, like the printed version, is published under
the Copyright Act.

The Internet in Education
We discussed ‘e-learning’ in a previous chapter where we showed how educa-
tion and training can be mmparted by using radio, television, CD-ROM. personal
network, and the Internet. In this chapter, we will have discussions especially on
the role of Internet in education,
You are very much farmiliar with the word ‘Internet’. Many people are using it.
This technology has brought about a significant change to the world, and some
mirastructural facilittes and financial solvency are required to use it. Either a
desktop or a laptop computer is necessary to use the Internet. It 15 expensive and
cannot be afforded by the majority of the population. Nowadays mobile phone
technology has been upgraded and the *Smartphone’, which can provide the
internet facilities, is within the reach of most people. However, the smart phone
is not always an effective tool for educational purposes. The screen of the mobile
phone is so small that its use 1z confined within the limit of viewing and
exchanging information. A recent invention, the tablet-an electronic device
typically smaller than a laptop. but larger than a smartphone, can be used in
education easily. Many companies are designing applications suitable for tablet
to use in education.

We can not avail the internet [acilities just by having a desklop, laptop. tablet or
smartphone suitable [or internet-use. An iniernet connection is required for that,
but it 1s not equally available m all the places of the country. The speed 1s not the
same. Sometimes a slow-speed inlernet makes i1s use meaningless. On top of it,
fast and high speed internet gervice cannot be afforded by the general people of
our country. Therfore, the students should get the internet connection t low cost
to use it in education.

Owur students' access to a laptop or tablet and high speed mtemnet will not ensure
the use of ICT for their education. The main question is what they will use in the
mtemnet. Is there any content suitable for them? In fact, there is not much content
available on the Internet in the Bangla language. Initiatives have been taken by
the Government, organisations, and individuals for developing content in
Bangla. We expect to get it very soon in the internet.

Many educational contents are now available on the internet. It a student cannot
understand anything while studying, he/she is sure to get any solution by giving
a search on the internet. If any student wants to learn anything, he/she will find

Forma-7, [CT-{%-110)

2025



2023

a0 Information and Communication Technology

it on the internet. The technologists of our country have successfully made
cffective search engines.

There are useful websites for mathematics on the Internet in which the answers
of any mathematical problem can be found. There are websites for practical of
scientific experimentations. Expert groups are formed by enthusiastic people,
and when problems are placed before them, they solve it. There are also some
useful sites available on the Internet for teaching Bangla.

A vast world of knowledge is on the Internet. Now we know that intemet plays
a vital role in any disas{rous situation. Use of internet in education will be
significant in near future.

The Internet and My Academic Subjects

Perhaps you hear that a teacher is like the flame of a light, and in darkness, they
kindle the light of knowledge that illuminates everything and the swudents see

the ways in the light. In other words, the best teachers in the world cannot teach
anything, but they can only help the learners to learn everything themselves.

Similarly, access to good content on the Internet will not always ensure great
learning experiences and sound education for students. The Intemet only
provides them with the opportunity to open a new world of knowledge. It
depends on the students themselves how much they learn from it. You must have
come across students who waste time on the Internet, either by playing computer
games or by bemng engaged in social communication siles. By contrasl, some
students learn computer programming availing themselves of the opportunity.
You have certainly noticed that all of your textbooks are available on the Inter-
net. In the beginning of the yvear, yvou get the textbooks. but if any book is either
lost or damaged for some reasons, vou can download it.

You will be pleased to know that some enthusiastic educationalists of our
country have started making oral versions of the textbooks in soft copies. so
that blind students can be benefitted from these oral versions.

NCTB publishes all the textbooks and sends it to vou free of cost. Besides,
many supporting books are also written (we are not talking of the guide books
that actually do not conwibute to learning). Those who write these textbooks
upload them on the Internet. Students can download these books directly from
the mtemnet without purchasing them from the market. Many writers of the world

Activity
How can the blind people be benelited by using digital content? Write a report
within 1000 words by taking help from the Internet.
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have arranged their books to be available on the internet. If vou surf the internet,
you will get vour favourite books free of cost. However, vou should be cautious
about downloading anv book preserved online, keeping in consideration the
Copyvright Laws.

We know that our students are not satisfied with what they get in the textbooks.
Therefore, they open science, mathematics or literary clubs. Once, students
could participate in the activities of the clubs physically, but now they have
access to the clubs virtually open on the Intemet. Now studenis of the whole
world can participate in the activities of the clubs and increase their academic
competence. Now-a-days olympiad on dilferent subjects are being arranged in
our country. You are increasing the fame of our country by participating in the
olympiad.

Web page

A web page or web in short is a type of document that is suitable for use on the
World Wide Web (World Wide Web-www) and Internet browsers. Therefore, the
file kept on the server of different countries for the use of Internet users is called
Web page. Web pages are usually created using HTML (Hyper Text Markup Lan-
guage- HTML). In addition to text or writing, images. graphics, animations, web
pages may contain various types of data files, videos, audios, etc., and links or
hyperlinks to other pages. And various types of program files are required to display
the content of the web page in the browser.

Web Site and Web Portal

A website is an allocated space or location of a computer properly connected to the
Internet to store one or more web pages.On the other hand, a web portal is a collec-
tion of links, content, and services within a website that are presented simply to
inform users, Any of the services on the website can be a part of the web portal. For
example: knowing the tlight schedule and ticket booking from the web portal of an
airline company.

Product advertising and product buying and selling services on e-commerce web-
sites are also part of the portal. A porial page manages (o present information from
an external source. As an example, Bangladesh Government's 'Bangladesh National
Information Broadecasting' portal (www.bangladesh gov.bd) can be mentioned from
where there is a system to get all kinds of necessary information at the government
level of Bangladesh.
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Web Server and Web Client

A website has two parts. Namely- webserver and web client. Client software takes
user input and sends data to the server called request. According to the data of the
client. server sends a response. Webserver is a special kind of Hardware or Software
that can provide services to a lot of clients at the same.

Wels Server Browser
— b HTTP RESPONSE

Wm [

For example, all forms of the Bangladesh government are available at forms.gov.bd.
For the convenience of the public, all the necessary forms of the Government of
Bangladesh are stored m a web enabled database which can be accessed by anyvone
on the Internet from that address.

&

4 .
[ eoe ]
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Generally, data is accessed from the database of an organization through web brows-
er software and displayed on the customer’s computer. Through the use of various
levels of middleware and other software, users can access previously protected data
over the Intemet or local area network. For example. a buyer can search online
through a web browser to find out the price of the desired product in the website
created through the web and database of various vendors, A buyer can even access
the seller's website from the comfort of his home through web browser software.

Web Client: On the Internet and World Wide Web, a user or client usually sends a
request for data or information to the web server using HTTP (Hypertext Transfer
Protocol) or HTTPS (Hypertext Transfer Protocol Secure) protocol. Client requests
are usually sent through the web browser and the result of the request is received
from the web server which is usually displayed in the web browser itsell. TCP/IP
(‘Transmission Control Protocol / Internet Protocol) protocol is a type of communi-
cation protocol used on the Internet to send messages .

Downloading: Downloading over a computer network is the process of getting
information from a remote system to a local system. That 1s, to store any information
from the computer network or the Internet on one's own computer or device. For
example: Saving a file from an e-mail or website to your device.
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Upload: Upload 1s sending data

from local the system to a remote commurity contont sites
gystem using the Intemnet or the : g s
network. For example: If some- : e
ong sends a file by g-mail, it is
91, - Uplad your ™

saved on that e-mail server. e ey
Web Browser

The Internet is called the ocean of information, because the Internet makes it possi-
ble to use all the information that is available on all the computers connected to the
network spread across the world. The software that works to display Internet infor-
mation or Web page or World Wide Web-WWW is called Web browser.

Web Browsing 1s visiting mterconnected Web pages or WWW hosted on web serv-
ers in different countries of the world. Various information can be brought to the
user's computer by web browsing. There are different types of sofiware for web
browsing. These web browsers usually display the web pages that are stored in the
web server computers connected to the Internet in different parts of the world. In
1990, Tim Bames Lee created the first web browser called World Wide Web. Note
that the World Wide Web is known as the world's first web browser.

Below are the names of some of the popular web browsers at present. Namely —

. Internet Explorer (Internet Explorer) or Microsoft Edge
. Mozilla Firefox

. Safari _ y N/

. f}pETa g ) '

* (jhmme Chndtieg Fanlos Inamme £ ppicine

. Internet Explorer P

. Google Chrome etc. {Q O @
-

Various words used in Web Browsing soft- aciawron Cpars Batar

ware are given in the next page -

URL: The complete address of a web site or page 1s called URL. The full form of
URL is Uniform Resources Locator. For example: http://wwiw.shikha.com: But note
that only www.shikkha.com or shikkha.com 1s not called URL. A URL has three
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parts. namely (1) protocol name, (2) hostname and (3) Name with location of the
filename. For example-

http://www.google.com/maps

Note that there is only one website with one name in the world.

Home page: The main page of an orgamzation, company or person's web site is
called Home page. It is usually set on the Start page. The web page that is set as the
start page on the web server is the user's homepage. That is, the page that appears as
soon as the web address is typed in the browser is the home page.

Bookmark: Bookmark is a web page list. From where you can directly go to that
web page by selecting the name of a web page.

Reload/Refresh: Reload/Refresh cormmeand should be given to know whether there
has been any change in the middle while reading the web page whose data is con-
stantly changing. Reload / Refresh command is very important especially for
dynamic webpages.

Stop: When data is downloaded on a web page and midway it is decided not to view
that web page, then the download must be stopped by clicking on the Stop button.

ey

Search

Go

Search: Finding something on the mtemet is called Search. There are several search
engmes to facilitate the search. Like- Google, Bing, Yahoo etc.

Search Engine : Search engine is a sofiware tool that finds information from the
world wide web. For example - Google. Yahoo, Bing, MSN, Ant etc.
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Exercise

1. Which one is essential to excess a website?
A. Desktop PC B. Tablet PC
C. Smartphone D. The Internet Connection

2. Which one 1s the constituent part of Information and Communication
Technology?

A. Computer B. Television
C. The Internet D. Smartphone
3. Digital contents are —
i. e-books, Blogposts and e-articles
1. into graphics and Animated Film
ui. audio and Video Streaming
Which one 1s correct?
A 1&il B. i&iii
C. 1 &iii D. i, ii & iii
Read the section below, and answer the guestions 4 & 5:

The father of Rini and Rony purchased a Tablet PC for them. Rimi and Rony
read in class IX and X respectively.

4. The best use of the Tablet PC for Rimi and Rony will be for -
A. Playing games B. Listening to music
C. Calculation D. Study
5. For the highest use of the Tablet PC. Rimi and Rony will need-
1, a faster internet connection
1i. cheaper internet service
iii. better skills in the English languace.
Which one is correct?
A 1&1 B. 1&iii
C. ii&iii D, 1, ii & iii
6. How can ICT be helpful for building up our career? Explain,

7. "Now it is impossible 1o study without the help of the Internet,' explain with
your arguments.
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After completing this chapter, we will be able to-
# explain the important aspects of a word processor;

describe the technique of using a word processar;

explain the important aspects ol a spreadsheet;

idnetify the fields of using a spreadsheet;

describe the technique of using a spreadsheet;

edit by using a word processor;

vV ¥ ¥V ¥V ¥V ¥

keep the details of account by using a spreadsheet.
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My Writing on Word Processor

Writing is a medium of expression. We have to write for different needs. It might
be a piece of literature like poem, short story. novel, diary, etc. In our daily life,
we have to maintain different kinds of accounts, both big and small, like
expenditures of daily necessities, house rent and result sheet of examination, etc.
Once, writing and keeping these accounts were very difficult, but now we have
a lot of softwares for doing these works due to the development of information
and communication technology. These softwares are called office softwares.
These softwares can be used in our desktop, laptop and smartphone. We have
word processors for writing and spreadsheet analysis sofiware. You have got a
preliminary idea about these in the previous class. Now you will get advanced
ideas regarding these topics,

Writing of anything means bringing the imaginary world to reality m words. We
know that human beings started the art of writing to communicate their thoughts
and their ideas and convey their imagination to others. Now ICT is being used in
this work. and the importance of word processing 1s immense n this regard.
Something written is required for receiving and presenting information on
television, mobile phone or computer. Now all types of writing are done by the
help of the word processor. The word processor provides lots of facilities in
terms of writing,.

= Any correction in writing can be done immediately. Because ol the varieties
of editing options, any piece of writing can be presented aesthetically.

* A piece ol writing can be presented in different ways, for example, by
enlarging or shortening the font-size, colouring, making boxes. efc.

+ There are facilities of inserting new paragraphs, deleting paris or rearranging
the whole writing without composing the piece of wrting from the
beginning.

* A document can be more attractive by inserting photographs, graphs, tables,
charts, elc.

* A document can be saved and used again at any time. The same work needs
not be done repeatedly.

*  Any part of a document can be copied to another one, it necessary.

Forma-8, ICT-(9-10)
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« It is possible on work with several documents simultaneously.
« By using find-replace command, a word in a big document can be found
and replaced quickly.

* When a document is needed for a repeated use, it can be saved as template to
avoid the wastage of time. For example, if it is required to prepare a
lab-report every week, it can be saved as a template.

* In a large document, such as. a research paper. tables, references, images,
bibliography, etc. can be inserted and edited within a very short time.

« Spelling errors can be corrected easily by the spell-checker. Automatic
correction of spelling is also possible in the word processor with its built-in
programimes.

« It is possible to print a document as many times as required by saving it.

* A document can be sent to any destination through the medium of
electronic communication.

« Files prepared in the word processor can be preserved easily.

* File management. an indispensable part of the modern office management,
has become easier for the word processor.

Besides, the word processing software provides more facilities. The number of
users are gradually increasing day by dav due lo its usefulness.

In the previous class. vou learnt the process ol creating and opening a new
document in the word processor. Now we will learn some new techniques for
which you need to use your knowledge and skills you have developed earlier.

Office Buttons and Its Options

A new window will open after running word 2007, This EE_?'I icon at the lefi
corner above this window is the office button. The options you will find by
clicking the button are shown in the following image:
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The following options are most important:

New: This button 1s to be clicked for opening a new document.
Open: It 1s to be clicked to open a document saved previously.
Save: To save a document, this button is to be clicked.

Save as: This button is to be clicked 1o save a document in several different
names keeping the original one.

Close: This button is 1o be clicked to close an opened document.
Formatting Text: Selecting Font Style and Colour

You have already learnt how to write using a word processor. What will be the
impression if an organised piece of writing is presented in a colourful way?
Certainly, it will look good. This task is called 'Formatting Text.'

Font Size
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There are letters of different styles in a word processor, These are called “Font’.
In formatting a text, the selection of font comes first, This selection 1s done from
the name of the font of font group from the drop-down box on the home-menu.
Pick the font that you like out of numerous fonts. Sometimes, it 1s required to use
fonts of different styles either to highlight or specify words or phrases. In that
case, select the requisite section of writing, select the font in the similar way.
Click the number from the dropdown box at the right side of the font box to
determine the font size. You can select the font colour as you like. Clicking on
the icon of the dropdown box of font group, the colour can be selected. There are
more facilities of fonts in the font group of home tab.

Activity
Composing a paragraph from your textbook in the word processor, format it by
using different font style, size and colour and finally save the document, giving

a name.

Formatting Text: Bullets, Numbering and Line Spacing

Our Eruits Ouwr Rivers

« Mango 1. The Padma

. Bladkberry 2. The Meghna
o 3. The Jamuna

* Litchi 4. The Surma

» Jackfruit 5. The Bhairab

* Coconut 6. TheTista

Sometimes we make lists of different things, and use either signs, or letters or
numbers to maintain serials., This 1s called bullets and numbering in the word
pProcessor.

There is an icon command for bullets and  fi= -_']fﬁ]fmm
numbering in the paragraph group of the —t—y imm

home tab.,

| MLE.I
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Activity
Write down the names of some of your ﬁwumc cricket players by using

bullets and numbering.

Formatting Text : Table and Different Illustration

The insert tab of ribbon is used to insert a table, image. clip art. different
shapes, chart text box, word art, ete. into a document.

table. (2) Then click table
and click (3) Insert table.
-~ You will get a dialogue box

|==H= jIHE _ number of columns and
(L] IJ et Vi Tows.
- o Activity
ﬁ i , | Make a group of 10 students, and arrange the name,
fatd'ller’s name, age and roll number of each student in a
table

Insert Picture

By mserting pictures, document
can be presented in attractive
way. For example., you are
watching a lot of pml‘ures ' i
along with writings in this |H=:' '
text. You have to click the Page | Table
insert tab of the ribbon of "“_"‘4 —
word 2007. Then click the o
picture icon of the illustration group. A dialogue box will come. Select a space
for the picture and the picture will be inserted into the document. Besides,

y
2
~
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facilities of inserting clipart, shapes, smart art, chart, ete. are provided in the
illustration group.

Activity
Insert a picture in the document prepared by you with the help of your teacher.

Insert Word Art

"m G e YOU can insert fonts of different
E.. o LR styles from the insert tah, and to
el b L _ choose your style, you have to click
Beiis! Wonldet Werklet »:-4: W word art of tnsert tab's text group. A
= P dialogue box will come, and you
et bl et Bt e e will get the desired stvle of your

~ text after selecting the font.
Setling up Margin

It is required to click the page lay

It | fagelmout | References  Malings ey OUL L@ of the ribbon to determine

D L} u = g.,m,. the margins of the text. Then

f3unenumners - clicking the margin icon. desired

urmphmﬂnn' . margin i8 to be set. Dilferent options

gl M""““"‘ = of margins will be on the screen

when you click on the margin icon. You can select the margin from the options
or use your own margin clicking the custom margin.

Marging Orientation  Size  Columns

Activity : 1
Render the name of your school in different styles of word art.
Activity : 2

Set the margin after preparing a document.

Line Spacing of Paragraph

Click the page lay out tab to
select the space between lines
of a document. It is needed (o
select the points before and
after lines in spacing of the 1 Paragraph
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paragraph group. The command can be given after composing the document. In
that case, first, the section of the document in which line spacing will be
inserted should be selected. Then it can be determined as per the instructions
given above.

Activity
Compose a part from either from your Bengali or English textbook and
determine the line spacing.

Insert Page Number

Inserting page number on every page 1s an
important task while composmg any document.
Clicking the page number of the header and footer
group in the insert tab on the ribbon. the right

Bage Matging
option can be chosen. You can insert page number ol s
either on the top or at the bottom of the page. ;ﬁ::::::;

Activity
Save a document composed by you giving page number.

Spelicheck and correction

One of the great benefits of word processing software 1s spellchecking. Any
spelling mistakes anywhere in the document can be checked and correcled.
Grammar can also be corrected in many cases. New words can be added to the
program's dictionary for spellchecking. The spellchecker detects misspelled
words and presents some possible correct words, so that the user can choose the

correct word. At this tme, the default P s

language of the dictionary has to be | ... i
determined. Otherwise, the apparent [|[{seremesngyisiyoumiouingse - [iporem ] |
correct spelling may appear incorrect. ,-:::-, 1
For example, il a word processor | . . = '
dictionary has Ametican English | Er— &:‘.‘__.."]
language selected and the word %:i
document colour is entered, it will be :

e ——

o Drecy e

detected as a misspelling. Because | [ gun e ||

|

colour is spelled in British English, it
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would be color in American English. Also, the spellchecker identifies scientific
names, names of individuals, organizations or places as errors. The user has to
ensure whether these words are correct or not.

Spreadsheet and My Accounts
Analysis of Spreadsheet

Let us have a look again on what the specialities of spreadsheet analysis are.
Specialities of Spreadsheet Analysis:

It is possible to work with statistics and letter-based data;

It is advantageous for any kind of accounts;

Classification is easier for the rows and columns:

It 1s possible to work with voluminous data by using formulae:

nsu-g.-.'. sl Wil fast = 0 X
'J ons |l Bl b S e e e B-=T
i DN ST AT B EE N Yemiom- 1S nill; S Rt . et b o 0 ) el
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+ Amnalysis of data can easily be done by using dilferent functions
methodically;
» Data can be presented with graphs, charts, ete.

Different Uses of Spreadsheet
A spreadsheet is an interactive computer application software used for
organisation, analysis and storage of data in tabular forms.
Different uses of spreadsheet are given below:

« analysing exam results in the education secior;

maintaining income and expenditure accounts:

« preparing budgets;

- maintaining records of employee salaries;

« making reservations for services, such as airlines;

« calculating and analysing income tax,

« counting votes in elections;

« analysing and evaluating performances of players.

Technique of Using Spreadsheet

You have already got some fundamental concepts of spreadsheet. You will get
advanced ideas in this book.

Multiplying

Put the formula in the result cell for multiplving in a spreadsheet. Formula
always start with "=" equal to. Multiplying process i3 ol two kinds:

S

| * Monthiy Shopping E s 1. Usunally press tllua enter
| oo tvme: | Pokew () | Qemmtiey (R | Bapemaliowe button, after putting the
3l formula into the result cell.

2. Press enter button writing spreadsheet function= PRODUCT in the result
cell and giving the cell range.

Forma-9, ICT-(9-10)
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D3 ~ (. J=| =PRODUCT(B3:C3)

B A [ 8 [ c ="'
1 Monthly Shopping Expenditure
2 Product Name Price (k)  Quantity (Kg) Expenditure _

3 Rice 44 40 1760 l
> . .

The facility of multiplying by using function is that the result of multiplication
of numerous cells can be done by range, if necessary. The process of
multiplying 3 cells is shown in the picture below:

- 'u =PRODUCT(A3:C3)
L8 | i

[4] A c DR
a1 Volume of Cube
2 Length ‘Width Height Volume

| 40 15 14 I 8400 |
4 | |

Activity
Opening a file of spreadsheet, multiply some imaginary data.

Method of Dividing

Dividing can also been done on the spreadsheet by a formula. You have to
write =A1/B1' in the result cell to divide Al by B1. Here the sign / is used as
the sign of division.

*| Activity
Try to find out the
result by using the
formula.
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Caleulation of Percentage

How much 1s 15% of Tk. 4007 What is the selling price al profil 16% at the
purchasing cost Tk. 12007 We frequently need to do this sort of calculations in
our practical life. We can do these calculations on the spreadsheet.

To solve the first problem on the spreadsheet, put formula =A3*B3% in the result
cell. The process of writing the formula in the result cell by using kevboard is to
write the sign = and click the cell where 400 1s written. Then press * and click the
cell where 15 is written. Then writing % (press shift key and 3), press the enter
button. You will get your result,

The formula =A3%*B3%+A3 should be used to solve the second problem. The
process of writing this formula is similar to the process mentioned above.

Activity
Solve the problems of calculating percentage under the guidance of your
teachers.

The monthly basic salary of Mr. Chowdhury is Tk 16500. He draws residential

allowance 4t the rate of 55% and medical allowance Tk ?ﬂﬂ* ‘He subseribes Tk
90 to the benevolent fund. What is his monthly net salary?

* Because of the version of software there may be difference in title and menu bar,
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Exercise
. Why is a document saved as a template?
A. For Aesthetics B. For frequent use
C. For rearrangement D. For the facilities of making copies
2. Which one of the following is used for saving the document for the first time?
A. New B. Open
C. Save D. Save As

3. By using spreadsheet analysis —
1. preparing a text 1s easier.
ii. a theory can be applied.
iii, data can be arranged,
Which one 1s correct?
A 1i&i B. 1& i
C. i & iii D. i, ii & iii
Read the section below, and answer the gquestion nos. 4 & 5:
Soumitra wriles on nature and environment lor a newspaper voluntarily.
Sometimes he has to attach picture of flowers, birds, or rivers. He is an
accountant by profession. He has to keep the account of the employee and
place a monthly report.
4. Which software does Soumitra has to use for his voluntary work?
A. Word Processor B. Spreadsheet
C. Graphics D. Database
5. In his professional work, Soumitra has to use —
1. the template.
il. Lheory.
lii. data arrangement,
‘Which one is correct?
A 1&1 B, &
C. n&ii D. 1,11 &iii
6. What kind of formatting is used in word processor for making a list?
Describe with examples.
7. Write five advantages of analysing spreadsheet.
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After completing this chapter, we will be able to -
# explain the concept of multimedia:
describe the method of multimedia:
identify the fields of using multimedia;
explain the idea of presentation sofiware;
analyse the significance of presentation software;
describe the technique of using presentation software;
explain the idea of graphics;
describe the technique of using graphics software;

Y VY V¥V VY V VY Y

prepare slides on different topics by using presentation software and
present it;

» draw creative pictures by using graphics sofiware and present it.
Concept of Multimedia

[Muman beings have been using different media to express themselves since the
ancient time. Writing is an expressive medium, and so are the sound and image.
Multimedia 1s the integration ol multiple forms of expressive media, such as
texts, graphics. drawings, photographs, videos etc. With the evolution of
civilisation and development in technology, these mediums have been used in
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various ways. Specifically in today's digital era, the nature ol these media has
also changed.

The media of the analogue age are not the major media of the digital age. Rather
the media of analogue age have changed in motive. Once, the media were used
separately. bul nowadays they are harmoniously combined together. The
potentiality of multi-media has been enhanced with the integration of
programming ability of digital machines. Hence. it i3 also called 'interactive
multimedia' because of its multiple dimensions and different programming
abilities. Inferactive multimedia is widely known to people. In summary.
multimedia means numerous media. Interactive media means the media with
which the users can connect and interact.

Multimedia is the combination of different expressive media. We express
ourselves by using, at least, three media which are colour, image and sound.
These three media have various forms too. They appear before us either
individually or collectively. Different kinds of media are known to us, such as
paper publication, radio, television, video, cinema, video games, educative
software, webpage, etc. We can call television, video, and cinema multimedia,
but video games, educative software, and webpage are called interactive
multimedia.

Multimedia is usually captured by a digital machine or device. It can be directly
presented on the stage or projected in a different way. Sometimes some
electronic devices are called multimedia because they contain the information
and directly display it in different forms. If we want to use three media in one
activity, we should start from the cinema. In the last phase ol 19th century, in
1895, with the mvention of cinema, text, graphics. sound and movemnent were
added to it. Therefore, cinema is called the earlier invention of multimedia. Even
though this form of multimedia came into being ages ago, the integration of the
computer to it 13 a quite a recent development.

Media of Multimedia

We know that the computer, the most popular digital device, is widely known as
the calculating machine. Processing and transferring data was another important
work ol the computer. Later on, it was widely used for typing,.

In the beginning, only one medium was used to do all these works. i.e. text.
However, gradually graphics and sound were used too. Besides, the computer
has the ability to do programming. In fact, computers are capable of creating an

mleractive experience for users with the combination of text, graphics and
sound. Now multimedia promised dynamic experiences than that of the previous

time. Multimedia is used not only in the computer, but also in mobile phones,
smartphones, tablets, and other digital devices.
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The main mediums of Multimedia

Text {%uund or Audio)

Multimedia

. p : Interactiv
Video Animation E%mpﬁuﬁné

There is a world-wide preferences for computers and they tend to replace the
conventional machines.

1.

Text: Any work in relation to written text is done on computers world-wide.
Once 1t was done by the typewriter. At present, computers are used for all
kinds of writing tasks in offices to professional printing houses.

Graphics: Computers are used for graphics design, editing, and so on. In our
country, the use of computer is very limited in graphics design, painting,
drawing, and even in commercial graphics included in Fine Arts. However,
computers are widely used in printers and packaging industries. The use of
computer started in 1990s in printing, publication and graphics design. It was
first used to edit scanned photos by Photoshop. Gradually, computers have
been used in design and graphies.

Video: Video is a kind of graphics. It is better to call it a moving graphics.
Video is an established medium all over the world. Video has been extensively
used in TV, Home Video, Multimedia Software. Web, etc.

Animation: Animation is a kind of graphics. But it can be either moving
or static. It can be either 2I) or 3D. The use of animation is gradually
mereasing in our country. In advertisement, animation 15 a [avourite
media, but we lack skilled people in this sector. In fact, animation
is never used as a single medium. It is combined with audio, video,
text, graphics, ete.

. Sound or Audio: The whole world depends on computer for sound or audio

recordings, editing, etc. The analogue system has been completely rendered
obsolete in sound engineering. Now sound recording can casily be done in
computers.
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Interactive Computing: In this connection, we should know a piece of
information about interactivity. Application of any style, such as Microsoft
word scroll or flash, into the texi or any effecis of animation imo the video
does not make the text or video interactive. Something created by the
powerful authoring software like *Flash’, *Director’, and *Authorware’ that
makes interaction possible between the user and the computer is called
‘Interactivity’.

Use of Multimedia in ICT
There 1s an increased use of multimedia in ICT.

1.

As teaching aid : The use of multimedia as a teaching aid is widely used.
The learner will understand a topic easily, if multimedia is used in the class
room. The teacher can easily make the lesson effective and mieractive.
Beside this, there are various kinds of multimedia software for education.

1.1. Multimedia Software : The multi-media software has just started being
made in Bangladesh recently. Multimedia technology has been used in
with 'Bangladesh-71'. 'Abosor’, Biswakosh', 'Namaj shiksha', Bijoy
Shishu shiksha', etec. They are not much mteractive. However, we expect
that in Bangladesh, muliimedia sofiware will be definitely developed
extensively in the 21st Century.

1.2. Digital Publication : Our publication i1s still paper-based, but the
21st century will definitely be the century of digital publication.

Entertainment : Multimedia 1s widely used in most of the genres of

entertainment. Cinemas and plays are being made livelier by the special

effects of multimedia.

Advertisement : Because of the use of multimedia, advertisements have

become attractive. Both real and fictional elements can be shown in
advertisements with the help multimedia.

Games : Multimedia is extensively used in computer games or video
games. Because of the use of multimedia, the games seem as real as real
life.

. Animation: Animation is moving or static graphics or images. It can be two

dimensional or three dimensional. The use of animation in advertising images
is a favorite subject. Animation is never used as a stand-alone medium.
Animation is usually created by combining audio, video, text, graphics etc.
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The man who works with text, graphics, audio, video, animation, ete. is called
the multimedia content developer. Many pieces of soffware like Adobe
Photoshop, 3D Studio Max, Maya, etc. are used for multimedia contents.
However, depending on the content that they develop and the interactive
applications that they use, multimedia contents developers should be called

‘multimedia programmers’ or ‘multimedia authors’. In fact, there is a
difference between developing contenis and adding interactivity. Adobe
Premier and Adobe Photoshop can make an interesting piece of multimedia
content. By contrast, in order to make the multimedia content interactive,
‘Director’, a programme ol creating soflware, combines the media made in
‘Premier’ and ‘Photoshop’ and creates an interacuve application.

In future, the demand and the number of multimedia programmes will definitely
never lessen. The demand of multimedia content developers and programmers,
along with business sofiware developers and maimtenance experts, 1s also
mereasing.

Presentation Software

Creating Presentation

It is the age of exchanging information and ensuring human welfare through free
flow of information. Now, the exchanging of information among the
researchers, educationists, social workers, and professionals of national and
international levels has been emphasized most. Meetings, seminars,
symposiums, and workshops are frequently arranged in order to ensure free

access to information. As a result, experts have up-to-date information about
their respective fields.

Presentation softwares such as PowerPoint, Picasa, Impress etc. are mainly used
to present information in an attractive and effective way 1n meetings, seminars,
symposiums, and workshops. ‘PowerPoint’ is a piece of popular software or
application of Microsoft Office. It is called ‘Presentation Software’ too.

Information can be presented attractively with texts. graphics, audio and video
through Power Point. In fact, right at the moment there is some alternative to
Power Point software. That is why it is widely used for presenting information
in meetings. seminars, symposiums, and workshops.

Just a word document in a Microsofi Word Programme, has numerous pages, a
Power Point presentation also has several slides. A page containing more than

Forma-10, ICT-{%-10)
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one slides is called *Handout’. A draft should be made for organized presentation
in Power Point. This draft is called ‘Slide Layout’.

Opening Power Point Programme and Creating Slides

To open Power Point Programme

L.

At the left comer below the screen, “Start” is written. It 1s the “Start’ button.

Click the “Start’ button by taking the mouse pointer on it, and a menu will be
viewed on the screen.

Place mouse pointer on the *All Programs” command and get a 'Fly out’
myemni.

Click the *Microsoft Office’ menu from this “Fly out” menu and get the list of

Point’ command from this list and the .
first shide will be shown on the |
screen. In the main part of the slide.

‘Click to add title® and *Click 1o add
subtitle’ are written on the box.
Click both the writings and a text
box will be shown with the insertion
pointer. Type a title and subtitle while o aas
the insertion pointer is in the box. If you click outside the box without
writing anything those two writings will be viewed again.
Click the textbox border and press delete button after selecting, the textbox
with the writing will be deleted.
Select the textbox icon from the ribbon of the *“Home" menu and take the
insertion pointer inside the screen and the insertion pointer will be changed
into a text pointer. { create a box, dragging)

Click to adhd title

- The insertion pointer will be on the box.

- The keyboard will be transformed into "Bangla® for typing in Bangla.

- Select font, fontsize, colour, etc. from the toolbar and ribbon for typing work.
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- 'mmmE o 18 typed selecting
Sutonny MI, [ont size 150 and blue
colour.

- The textbox will remain selected
after being typed. There will remain
round and hollow selection points,
four on the four arms of the selected |88 -
box and four on the four comers. Dragging these selection points. the size of
the box can be made small or big either sideways or from the top to the

bottom to contain texts. The selection will go away if vou click outside the box.

- The box can be moved to any place of the screen by chicking any arm of the
box and by dragging it.

- On the left side of the slide making window, the small version of the shide 1s
shown in thumbnail view.

Saving Presentation

- Give the Save command from the file menu, and Save as dialogue box will
come.

- Type the name of the [ile in Save as dialogue box. Suppose that the name is
‘My Country.”

- Click the button ‘Ok’ in the dialogue box. and the presentation will be
saved as "My Country”’.

- The file can be opened next time to complete the unfinished work.
Adding New Slide

Many slides may be included in a single presentation. To add a new slide

1. Select the command of New Slide' on the ribbon of the ‘Home' menu or

Press Ctrl+M from the keyboard. A new slide will be added.

‘Click to add title” and *Click to add text’ will be shown on the newly added
slide. Both the writings will be deleted following the previous directives.
The small version of the newly added slide will be shown on the left side of
the Window in thumbnail view.

2. Type the title of the new slide ‘a3 (%7F 95787 in the textbox following the
process described earlier.
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Following the same process, type the three titles in three different boxes:

YBEY FANEE X3 CRGHIE ©IF WOHECE (F9F Loy .

e =ifmera wefew W T oemr d»ad S (AT SRTE

G Ak WY WiNTAe wiEmer W @ e [; o o e e
(e Yfewm vy g
Voay HiTE Mo TorTET wae ey e @ DR el L

A . oo el
e Wit o1 e

- — = o -

The three boxes will be placed one afier another from top to bottom. The
title will be on the top. Another slide will be added following the process of
adding the second one. That will be the third slide. To add this slide

Type ‘g77am" as the title of the new slide
in the textbox following the process
described earlier.

By adding numerous slides, complete the
work of presentation as required.

After preparing the primary presentation, W% Hatan
&dd]ﬂg different varieties make the entire m
presentation altractive.

Display Slides in Presentation

Making two slides for presentation, check it whether it has been workable as
well as presentable. For completing the (ask,

Press the button F5 from the keyboard or select the Slide Show on the ribbon
of the View menu or click the icon of Slide Show on the status bar, the first
slide of the presentation will be displayed.

For viewing the next slide of the presentation, press the right arrow of the
keyboard, and to go back. press the left arrow.

For starting the next slide show from the middle of the presentation, press
Shift F5 button.

Press the Esc button to revert to the window of editing from the window of
slide show.
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You can be sure whether the slides are presentable or not by checking at any
phase of preparing the slides.

Changing the Background of Slides

The color of background can be changed either during the processing or after
the making of the slides. Any image can be used as the background of the
slide.

Adding or Changing Background to the Slide

1.

To use more colors, textures and images
¥:

Keep the slide open or active to add a background to it. The first slide of the
current presentation is kept open.

If vou click on the drop-down bar of [~ ————

Background Style on the right of the = '« l,_,___ﬁ- e
ribbon of the Design menu, a paletie of | =
gradient and solid color will come on the |
screen. If the mouse pointer is placed on a
color or gradient of the palette, in the
original slide, the background of that

color or gradient will appear.

-
Oarh by s w—

alllimn

B -

Select Formal Background al the bottom. and a dialogue box of that name
will come on the screen.

Clicking the Solid Fill Radio button on the left above the Format
Background dialogue box; make it active. Click Color Drop-Down Arrow,
and a color palette will be viewed on the screen. The color swatch, which
will be clicked from this palette, will fill the background of the shide.

Clicking radio button of Picture or Texture Fill, make it active, and Texture
drop-down will be viewed instead of color. Click this drop-down arrow,
and different kinds ol texture will be shown. The texture swatch, which
will be clicked. should be selected from the original slide.

The dialogue box called Insert Picture will come if the File button below
Insert Box 1s clicked as the radio button ol Picture or Texture Fill is selected.
Select the picture opening the folder of the dialogue box that contains the
picture.
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Click the Insert Box button of the dialogue box, and it will disappear, and
the picture will be set as the background of the slide.
To remove the imposed background —

Click the Solid Fill radio button of the dialogue box of Format Background
and make it active. Click the drop-down arrow of Color, the palette will be
viewed on the screen. Select White from this color palette.

Click the Close button of the dialogue box.

Insert Picture in Slide
Sometimes, it may require to insert a picture on the slide.

To insert a picture into a slide

.

the Insert menu, and the dialogue box of | = =
Insert Picture will come on the screen.

Open the folder of the dialogue box of
Insert Picture in which names ol pictures
are available. After selecting the picture
you prefer, click the Insert button. The
selected picture will be added to the
slide.

Clicking the resize box and dragging it, the size of the picture can be
resized and replaced elsewhere, if required.

Inserting Transition into Slide

Usually slides are presented one after another, and effects are used to shift
from one slide to another, This effect is called *Transition’, It works on the
slide into which transition is applied by keeping it open. To insert Transition
inio a slide

L.
2.

Keep the first slide open.
Click the Animations menu to activate it.

Arumations '| ihn;t:lhpn_ Apitew  Wiew

- .ﬁlllmlln Liiire

s e S S T e

sl Appty To A4
_mmﬂn_h!ﬂ.!!ﬂ_
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On the ribbon of Animations menu, a row of Transition samples will be viewed.
On the ribbon of Animations menu. a row of Transition sample will be viewed.
The sample on which the mouse pointer is placed will be viewed in the slide.
There are three arrows on the right to pick more from the given samples. If you
click repeatedly on the middle arrow, a new row will be viewed with every press
of the mouse button. If you click the arrow on the top, a column will appear. If
you click the arrow at the bottom, all the samples will be viewed, Click the
sample chosen, and the ransition will be applied to the slide.

3. If you want to apply the same transition to all the slides. click *Apply to
All” button on the right side after applying it to the first slide.

4. If you want to apply a different transition to every slide, you have to apply
it separately following the same process for every slide.

Applying Transition Separately in Text

One slide may contain several textboxes. There are texts in three textboxes in
the second slide of the current presentation. If different transitions are applied
in these three textboxes, they will come to slide in three different processes. To
insert transition {o the textbox

1. Keep the second slide open.
2. Select the textbox.
3. Click the Animations menu to activate it.

A command called Custom Animation will be added to the bottom of
Animation. Click Custom Animation and a palette will come.

4. Select Entrance from the Add Effect drop-down list of Custom Animation,
and a list of custom transition will appear. From this list

- ‘Bhinds’ 15 selected for the first textbox.
- “Flyin’ 18 selected for the second textbox.
- ‘*Diamond’ is selected for the third textbox.

- If you select ‘More Effects’ from this list, another list of transition will be
viewed. Selection of any transition from this list will show the same effect.

5. In order to remove a transition from a specific textbox. select it. Click the
‘Remove’ button to exclude the transition.
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Apply Sound te Transition

Keep the slide open to add sound to the {ransition, and select the name of a sound
from the drop-down list of Transition Sound. Camera is selected for the first
slide. Click Apply to All button for applying the same sound to all the slides.

If different sound is required to apply in every slide, separate application of
sound following the same process for every slide will be needed.

Add Video to the Slide

Video can be added to any slide. if necessary. Usually video is added to the
introductory slide. Suppose that video will be added to the introductory slide of
the presentation on Our Country. For this

- Keep the introductory slide of the presentation open.
- Clicking the Movie drop-down on the ribbon of the Insert menu, get “Movie

from the file’ command. Select the command and ‘Insert Movie dialogue
box’ will come.

- A movie file will be selected [rom the video folder ol the Insert Movie
dialogue box.

- Click the Ok button of the dialogue box.

- A message box with a question "How do you want the movie to start in the
slide show?” will appear.

- The Messaging box will contain two buttons ‘Automatically’ and ‘“When
Clicked.’

- The Messaging box will disappear if required button is pressed, and the
video file will be added to the slide. You can place the file anywhere on the
slide by dragging it and resize it by dragging the resize box.

- The first slide wall appear on the screen if you press F5 on the keyboard.

- The Thumbnail view of the video file will be shown on the screen.

- Click the Thumbnail of the video file and it will start plaving.
If ‘Automarically” was selected at the time of adding the file, it will start
playing with the display of the slide.

Activity

Make a power point presentation about your schooel and present it.
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Graphics
Importance of Graphics

Photographs, drawings, paintings, illustrations. designs, etc. have to be scanned
and transferred to the computer first for editing. Now pictures captured by a
digital camera can directly be copied to the computer. Afier the editing, these
photos can be used on printed invitation cards, posters, banners, advertisements,
etc. through the digital media.

There are numerous programmes to edit photos in computer. Of these
programmes, Photoshop is popular worldwide. Brightening or darkening the
entire or a part of picture, designing the cover ol a book with several pictures,
making posters, cutting off any irrelevant part of the picture, erasing blotchy
marks on the picture, etc. can easily be done by Photoshop.

Photoshop, an editing software should have been installed in the computer or it
should be installed. Editing can be done on a file created earlier.

To open Photoshop program

1. Click the start or Logo button of Windows and place the mouse pointer on
the “All Programs’ command, and get the Fly out menu.

2. Chick Adobe Photoshop Programs, from this menu and ‘Adobe Photoshop®
will open.

To prepare new file in Photoshop program

- Click ‘New’ from the ‘File’ menu after opening up the Photoshop program,
and get 'New' dialogue box.

- You will get ‘Untitled-1" selected m the square space of *Name® of the
dialogue box. Pressing the backspace button of the keyboard, erase the
writing and type a name. It will be the name of the file. Suppose thal
‘Practice” is typed in the *Name” box.

If you type the name in (his stage, you need not to type 1l further. While
closing the file, a new dialogue box will come when you will go to close the
file.

- In the box of “Width” and ‘Height™ in New Dialogue Box, type numbers on
the measuring unit ‘inch’, for example, width of 7 inches and height of 8
inches. There 18 a dropdown menu to determine the unit of measurement on
the right side of these two boxes such as inches, pixels, piacas, points, cm,

Forma-11. ICT-(%-10)
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mm. Select the requisite unit from this dropdown menu. Fix the
measurement by inches. Suppose that the measuring unit of the present task
is inch, and 7 in the box of width and 8 in the box of height have been

typed.
The Resolution, for example, 72 Pixel, is kept unchanged.

Images or pictures are crealed in Photoshop by pixels. Pixel is the smallest
square unit of image. 72 pixels per inch mean crossing 72 lines vertically and
horizontally in per inch space. The total number of pixels in one square inch
will be 72°72= 5184. The number of pixels in per square inch is called

resolution. If 130 is typed in the box of pixel, the resolution will be
1307130=16900. If an image is enlarged, the pixels could be visible, This view
15 called pixelated. In simple words, 1t 1s called split image.

From the dropdown menu of color mode in the dialogue box, RGB.
CMYK, Bitmap, Grayscale, and from Lab Color RGB can be selected as
all the images on the monitors of computer, television. and other electronic
media are viewed in RGB mode. RGB is the abbreviation of red, green and
blue.

There are three options in the ‘Background Contents’ of the dialogue box.
The options are White, Background and Transparent.

If “White® is selected [rom the dropdown menu, the background will be
white. If a colour is selected from Background toolbox, it will turn info the
colour of the canvas. If transparent is selected, the background will be
transparent and checkered. The background option can be selected as you
like. White can be selected here too.

Without following the steps described above, Default Photoshop Size can
be selected from the ‘Preset dropdown list. Thus, all the units of Photoshop
will be selected as per the requisition.

Completing the measurement of the dialogue box, press "OK".

A window will be viewed as per the measurement given in the dialogue
box. On the left of the screen, Practice @ 100% (RGB/8) will be viewed.
This bar is called the title bar. If any name is not used in the Name box of
the new dialogue box, Untitled-1{@ 100% (RGB/8) will be viewed on the

title bar as the file name.
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The screen can be com-

pared to the canvas of Nl e (a3 (o

painting of an artist. On the -

left side of the canvas, are “a

the brush, color, and differ- 1

ent kinds of editing tools, %

and on the right side is the " e

palette e | e—
= e el - R

Double click on the title bar, and 1t will be viewed on the screen.

The menu bar is located under the title bar and the option bar is below the
menu bar.

The ruler is located below the option bar.

The Photoshop work 1s to be done below the ruler on the screen.

The Toolbox of Photoshop and Palette Distinction

At least 69 kinds of tools are there in the Photoshop. Besides, numerous options
ofl palettes, dialogue boxes, ete. are there. There is a relationship among dillerent
tools, option palettes, and dialogue boxes.

In addition, the brush colour or foreground and colour control 1con are there for
the canvas or background and visual space control icon for the monitor, mask
icon, etc. I a line is drawn either with the pencil or with the brush tool, the color
of foreground works as the color of brush.

Different palettes are kept on the right side of the screen. The minimise icon
is viewed above the right side ol the paleite. The palette will be minimised if
you click the minimise icon. It will be again extended if vou click the
Maximise 1¢omn.

If you double click on the top bar of the palette, it will be
either maximised or minimised.

Mirvs S0t

Clicking and dragging the top bar, the paletie can be il
replaced anywhere, oty
There 15 a toolbox on the left side of the screen. It has w‘_"‘:"

included different kinds of tools for different jobs. The — ras 55w e
tool, which is required to work, becomes activated when 7~ Lesl “T T
clicked. If the mouse pointer is taken inside the screen after e mL“ piinkin
selecting a tool of the box, the tool is either viewed on its LII_‘ Ry
actual size or as a plus (+) sign, and the editing tools are

viewed as circles.
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Selection of Tools and Acquaintance of Move Tools

3 selection tools and 1 move tool are viewed on the top of the tool box. At the
bottom of the right side of some tools, a small arrow sign Z is viewed. It
indicates that in the same position, more tools of the similar types remain
there. For example, 4 Marquee tools in the same position and 3 Lasso tools
in different positions are there,

Place the mouse pointer on the tool, and the name of the tool will be
viewed. Click the tool to activate it. If the mouse pomter 1s brought inside
the screen, it will be viewed either in the own shape of the selected tool or
with a plus (+) sign.

Making squares, circles and objects is possible with the marquee tool within
the selected tool.

By pressing the shift button and draggmg Rectangular Marquee Tool, a
perfect square, and pressing the shift button and dragging Elliptical Marquee
Tool, a perfect circle can be drawn. I you drag while pressing the Alt button,
selections of square and circle can be extended from the centre point.

Shifting of Selection

Fill Colour in the Floating Selection

After making the square of selection by Rectangular Marquee Tool,
remove the finger from the mouse, and the selection of square will be
viewed on the screen.

If vou take the mouse pointer inside the selection, a rectangular icon will be
viewed below the pointer, Pressing and dragging, the selection can be
shifted elsewhere.

Select the "Deselect’ command from the Select menu or click the mouse
pointer outside the selection while it is floating. It will go away.

There are colour icons of ‘Foreground' and
‘Background® at the bottom of the toolbox.
The icon above is for ‘Foreground’ and the
icon below is for the *Background’. Te fill a
selection with colour while floating:

Press Alt+backspace, and the selection will
be filled with the colour of the brush or
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Foreground. If you press Cirl+backspace or only backspace, it will be [illed
with the colour of Background or canvas.

- The selection filled with colour will float. Tt can be shifted elsewhere by
dragging.
- The object will stay at the same position after shifting the selection.

- If the shifting is done by pressing the Ctrl button, the object being shifted
will be cut.

- Press Cul and Alt during shifting, and the object being shifted will be copied.

- The selection will go away il you click the mouse pointer outside the
selection.

The Use of Feather

- Typing the number from 0-250 1n the box of feather on the option bar, the
edge of the object can be softened. The room of the feather extends equally
from the edge of the object to the inside and outside. If 10 is typed in
the feather box. the softness of the edge will be 20.

- The feather effect will be activated by pressing enter button afier writing
different numerical [igures m the box. Fill colour by using either the
rectangular marquee tool or the elliptical marquee tool. and the effect of
feather will be visible then. The effect will be still viewed after pasting the
cut or copied object.

Select with Lasso Tool and Polygonal Lasso Tool

- Select the lasso tool in  the toolbox,
Numerous selections can be made with
lasso tool such as

EEE @i

- Clicking and dragging on the canvas after
selecting the lasso tool, selections of |,
a non-circular and uneven edges can be
made. If vou release the finger from the
pressing position on the mouse while
dragging. a closed selection will be
created from that position to the first
clicking point.

N E Tl L
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‘m
>

- By clicking inside the selection while floating, it can be shifted elsewhere by

2025



2025

86

Multimedia and Graphics

dragging. Filling any floating selection with colour, it can be filled either
with the same or a different colour.

Opacity 1s used to determine the thickness of colour.

The 'Fill' dialogue box will come after giving the 'Fill' command under the
"Edit" Menu.

The foreground is kept selected in the *Use’ box of *Contents” under the
‘Fill" dialogue box. It can be changed from the list of the dropdown menu, if
required.

In the opacity square of the dialogue box, type a number (0 determine the
thickness of colour. The full intensity of colour is 100%., If the percentage is
small, the colour will be light. Type 50 in the Opacity box, and click the OK
button, and the foreground of the selection will be filled with 50% of the
total thickness.

There is opacity in the option palette of selection too. The intensity of
colour can be increased or reduced by selecting the opacity of this palette.

Stroke

The border of the selection can be made with the ‘Stroke’ command.

Select the *Stroke’ command under the 'Editt menu as the selection is
floating, and you will get the 'Stroke’ dialogue box.

Any number from 1-16 can be typed in *Stroke Width Box®. The extension
of the border is determined with this number. To create the border outside.
mgside or at the middle of the selection, activate any of these three options
by clicking the radio button attached with them.

Click the ‘Ok’ button of the dialogue box.

Borders can be created either by using the colour of the brush or of the
foreground in the Stroke process.

Saving File

Give the ‘Save’ command from the ‘File’ menu, and the "Save As’ dialogue
box will be viewed.

In the box of *File Name’ of the 'Save As' dialogue box, type the name of the
file, for example, Practice’.

Click the *Ok’ button in the dialogue box, and the file will be saved as
“Practice’.
*Practice” can be opened for further work later.
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Layer

An idea of Layer 1s required before creating objects or editing photos. Almost al
every stage of editing photos, you have to work through Layer.

Layer 1s the screen of editing photos or the phases of a canvas. In this process,

editing can be done by putling numerous transparent canvases one alter another.

[ the canvas is transparent, editing becomes easier as the existing photos can be

watched, but if the canvas of the upper laver is not transparent, the editing of the

lower layer cannot be seen. If any photo with colour background 1s opened,

Background' will be written on the layer palette. The background will not be

transparent in spite of being white because white 13 a colour.

- Suppose that a file with the
picture of a flower is opened. |
‘Background’ 1s writien on
the layer palette. An icon of a
lock 1s viewed to the right of
the layer bar. It indicates that ||
the layer has been locked.
The object of a locked layer [
cannot be shifted by clicking g
or dragging with the *"Move® tool.

- I "While” 1s kept as *Background Content’ and *Background™ while opening
a new file, “Background’ will be viewed on the layer palette.

- ‘Background’ can be transformed into a layer to shift the sample picture of the
flower elsewhere.

To accomplish the task

- Double click on [}
“Background’ of the layer || |
palette, and a dialogue box
named ‘New Layer® will be [| |
shown. In the ‘Name' box || %
‘Layer 0’ will be viewed. [}
Click the OK button of the £ - -
dialogue box, it will disappear, and the ‘Background® layer will be
transformed to 'Layer (. The ‘Background’ layer will be *Laver 1" if it is
written after erasing ‘Layer (' in the ‘Name' box of the dialogue box.

= 8 | 4 a3

2025



2

20

88 Multimedia and Graphics

- Ifyou click on any part of the picture with the *Background Eraser’ tool, that
part will be erased, and the layer of the palette will automatically be
transformed into ‘Layer 0°.

- If any part of the picture is erased by the Eraser tool, the layer will not be
transformed into ‘Layer 0°.

Insert New Layer

Many layers should be used to work with more than one file in Photoshop. By
keeping different pictures on different layers, their arrangement and editing
should be done.

To add new layers in palette

- Click the ‘Create a New Layer’ icon below the palette, a new layer will be
added above the existing or selected layer. This layer will be a transparent
one. To create any new object in the newly added layer, shift it elsewhere if
required. If five layers are created in this way, layer no. 2 will be above layer
no. 1, no. 3 will be above no. 2. no.4 will be above no. 3. [f more layers are
added, those will be arranged serially.

- The arrangement of steps can be changed it required clicking layer no.2 and
pressing on the mouse, drag it and release on layer no. 3, and it will be placed
n between layer no. 3 and 4. After the selection of dividing line between two
layers, release the pressure on the mouse.

You should remember that "Background Layer® can not be shifled in this way.
Background should be transformed into laver to replace it into another stage.

Make Picture Visible and Invisible on Layers

Therg is the icon of an eye on the extreme left of every layer. This icon is called
‘Laver Visibility Icon’. Click on the icon of eye, it will disappear along with the
picture on the screen. Click again on the emply place ol the eye, and the icon will
be visible again, and the picture on that layer will be visible again. The picture
of the flower on the layer can be made wisible and invisible for
experimentation.

Thumbnail Icon

There 1s a thumbnail icon on the right side of the icon of eve. The meaning ol
thumbnail means the miniature version of a large picture. This miniature version
on the layer along with the picture on the screen is viewed in the thumbnail icon.
It facilitates the editing of the pictures on particular layers.
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Clustering, Integrating and Segregating Palette

Numerous palettes can be panelled together. For example, Layer, Path and

Channel can stay together. The names of the palette will remain as tabs. The tab

which 1s clicked will be activated. The combined situation of several palettes 1s

called clustered palette.

- The present paletie 1s activated as a ‘Layer Palette’. Click the laver tab and
drag it outside the palette to release. The Layer palette will exist as an
individual or single palette.

- Again clicking the tab of the individual Layer, release another palette
inside by dragging it. Thick lines around the palette will be viewed. Thus
the Layer taken by dragging will be included in the cluster.

- If the ‘Layer’ paletie is not viewed on the screen, select the ‘Layers’
command from the “Window’ menu, and you will get the ‘Layer’ palette.

Making Layer Object

The process of making Selection and filling it with colour has been learnt. Now
we will learn how to make two simple objects with rectangular and circular
selection tools. We will learn how to write using the text tool too.

A. Crealing a recltangular object on Laver no. |:

- Select White from the option of Background Contents of New dialogue box.
and Background will be the base of the Layer palette. For making a
transparent layver on a white background.

- Click on the icon of Create a New Layer below the palette, and a new
Layer will be added above the selected layer. This will be Layer no. 1, and
it will be transparent too.

- A rectangular selection will be created on Layer 1 with the Rectangular
Marquee Tool, and that will be filled with green colour.

- The rectangular object can be shifted elsewhere by the Move tool.
B. Insert Layer no. 2 in the panel. and make a circular object:
- Click on Layer no. 1, and it will be selected.

- Click the icon of ‘Create a new layer’ below the palette, and it will be a
transparent layer.

Forma-12; ICT{9-10)
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If the New Layer command is selected from the dropdown menu of the layer
palette, the New Layer dialogue box will be viewed. In the square space of
the Name of the dialogue box, Layer 2 will be viewed. Type Circle in the
Name box and press the Ok button. and the dialogue box will disappear. A
new layer named Circle will be inserted above layer no.l in the layer palette.

Now create a circular selection with the Circular Marquee Tool so that half
of the circle will rest on the green field and the other half on the white.

The selection will be filled with red colour. and a red circle will be viewed
in thumbnail ol Layer circle.

. Preparing Text Laver

You should keep in mind
that if text is started with
the Type tool, the text will
automatically be written
on the Text layer. The new
text layer will be
transparent.

To write on Text Layer:

Click on the canvas selecting the Type tool from the toolbox, and instantly a
new layer will be added to the Layer Palette.

Selecting the Text tool, click the mouse pointer on the canvas. and the
requisite dropdown option list will be found on the Option bar to determine
the tont. font size, etc.

Select SutonnyM] from the dropdown list of fonts.

The size of the font will initially be selected 72 from the dropdown list of
font.

The font colour will be initially black.

Type ‘W& 9T, and it will added as a new layer. The letter *T" will be
viewed as a thumbnail of the text layer on layer palette.

The text can be shified elsewhere with the Move tool or the mouse pointer.

Now the square, circle, and text can be shifted anywhere with the Move tool.
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- If the combined position of the three objects is satisfactory, the file can be
saved for further use.

Transferring Picture from One File to Another

All the pictures should be transferred to a single file to work together. Prepare
an empty file named Default Photoshop Size. Another file called Banana is
opened with the pictures of bananas. Now clicking on a banana with the Move
tool. and drag it to the Window of the empty
file. The picture of the banana will be shifted to
the empty file. Close the file of Banana.

In the same way, more pictures of mangoes,
pineapples, elc, can be prepared and shilled Lo
the new file.

Fixing Target Laver
- The layer in which the picture is edited is called Target Layer.

- Any picture of any layer can be edited whenever required. The picture of a
single layer can be edited once.

To change a layer into Target Layer:
- Click the mouse pointer on the layer, and the layer will be changed into the
Target Layer. The Layer will be viewed and selected then.

Changing the Opacity of the Layer

- Opacity 1s the intensity of colour. In the opacity text box on the right side
above the Layer paleite, 100% is viewed as the full intensity of colour. If
you put mouse pointer on Opacity, it will be transformed into a
two-pointing arrow. When it will be dragged to the left. the opacity will
decrease, and when it will be dragged to the right, the opacity will increase.

- Or by typing a numerical figure in the opacity textbook the opacity can be
changed.

Removing Laver
Select the Layer to be removed. Then

- Give the Delete Layer command from the pop-up menu of the Layer palette.
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- After selecting the Laver. click the icon of Delete Layer below the palette,
and a dialogue box with a question, *Are you sure you want to remove this
Layer?” will come. If you click the “Yes® button, the layer will be removed.
but if you click *No’, the removal process will be stopped.

Combining or Merging Layers

Sometimes it is required to edit all the layers together in Photoshop. After

finishing the task, if it is required to take a print out by a different printing

machine, it should be copied on CD or pen-drive. The size of the file will be

small for getting this task done smoothly. The size of the file will be

conmparatively small if the layers can be combined.

To combine layers

- There are three cornmands called Merge Visible, Flatten Image. and Merge
Down on the pop-up of the Layers palette.

- If any layer 1s mvisible, give the command of Merge Visible, and only the
visible layers will be combined.

- I'the Merge Down command i3 given, the selected layver and the layer below
of it will be combined.

- If you choose Flatten Image. all the layers will be combined.

- If there is any invisible layer, an inquiring message will come whether it
will be removed or pot. Click the Yes bution, and the invisible layers will be
removed and the visible layers will be merged.

Cut, Copy, Paste and Paste into

You may select any object or image either fully or partially, and cut, copy and
paste it. I you paste any object alter culting or copying, a new layer is created,
and the object is pasted on the new layer. IT any transparent layer is created
before pasting, any cut or copied object can be pasted on the layer.

The Use of Crop Tool
The border of pictures collected
from different sources can not be B8

perfect or precise. It can be B
required to cut off the edges or e
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unnecessary parts, In spite of that, the image can also be tilted to one side.

Before starting editing, this kind of problem can be mended. The Crop tool is
used to cut off the unnecessary parts of an image. Crop means cutting off.

The border of this old picture is uneven, and the first step of editing the
picture will be cropping out the uneven edges. To get it done:

Select the Crop tool from the toolbox;

Select the necessary part keeping the uneven parts outside by clicking and
dragging it like the rectangular marquee tool.

Eight hollow square boxes will be viewed, four on the arms of the selection
and four on the comers. By clicking any one the boxes and drageing it, the
area of the selection can be either reduced or increased.

After fixing the selection area, press the enter button of the key board, and
the area outside the selection will be cropped.

If you think that the crop command should not be given even after selecting,
press the Esc button to unde the effect. Selection can be made again if
required.

Cropping up Tilted Picture

To crop any tilted picture, the picture 1s to be opened and the Crop and
Straightened Photo command is to be selected from the sub-menu of
Automate command m File menu. This process is applicable only for solid
background. If the background is of multicolor, the work of cropping will be
impossible. In that case

Select with the crop tool.

The mouse pointer will be transformed into a curved pointer or roiate tool.
The selection will be attached with the tilted position of the picture, and the
area of cropping will be finalized with other handles.

Press the Enter button, and the cropping up of the picture will be done. and
its positioning will be straight.

Use of Eraser Tool

When any color 1s erased by the eraser tool, the color is covered with the
color ol the canvas. If the color ol the canvas is white, il seems that the color
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is being erased, but if the color is different, it will be viewed. The picture
on transparent layer will be simply erased.

Press Cap Lock to erase the minute detail. and the eraser tool will take the
shape of plus (+) sign. The editing of small parts will be done then.

The work of erasing can be done by selecting a brush. pencil, or block from
the list of Mode drop-down of the Option bar on eraser tool. The rubber
eraser works like an electronic version if a block is selected. The Opacity
options of other tools can be used if they have been selected.

Creating Blend with Gradient Tool

The paint Bucket Tool is kept on the same position of the Gradient Tool. I you
select the Gradient tool, icons of creating five kinds of gradient will be viewed

on

the Option bar, for example, Linear Gradient, Radial Gradient, Angle

Gradient, Reflected Gradient and Diamond Gradient.

Blurring of a color [rom the
beginning to the end is called
blend. The color blurs from the
beginning edge to another in

linear blend. On the contrary, in radial blend, the color diffuses either from the
centre to the periphery or the periphery to the cenire.

To create linear blend with gradient tool

A selection of 3 inches width and 2 inches high can be created.

After selecting the gradient tool, bring the mouse on the canvas, and 1t will
be transformed into a plus (+) sign. Now drag it from the lefi-middle of the
selection to the other end, and release the pressure of the finger from the
mouse pointer. It will be viewed that the selection starting with deep black
color gradually diffuses to the end.

A blend can be created from all directions. If anything is not selected, blend
will be created through out the screen.

Activate the radial gradient icon on the option bar by clicking it [or creating
radial gradient.

The mouse after bringing onto the screen will be transformed into a plus
(+) sign. Now drag it from the middle of the selection to the other end, and
release the pressure of the finger from the mouse pointer.
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Editing Gradient

The editing of gradient can be done by starting, fimishing, and changing or
combining colors in the dialogue box. To get the task done

Gradient Editor Dialogue box can be viewed by clicking on the gradient bar,
Color Stop triangles can be viewed on [r—

the left and the right end of the rr o ===
gradient slider of the gradient editor W =

dialogue box. and the Opacity Stop - e =
triangles are found on the top of the k. S v

same dialogue box. Suppose that the e .
starting color of a linear gradient is 1__ ‘

red and the finishing touch is yellow. - . Y
To use blue instead ol red

Click the Color Stop Triangle at the lett end of the gradient slider. and a color
swalch will be activated at the end. Click the Color swatch and the Select
Stop Color dialogue box will be viewed. Selecting the blue color in this
dialogue box, click the Ok button, and blue will be the Stop Color at the
left-end on the gradient bar. Now drag with gradient tool from one end to
another, and a gradient of a combination blue and vellow will be created.

If vou select the Color Stop at the bollom edge and Opacily Stop on the top
edge of gradient slider, a diamond shaped icon will be viewed in the middle.
This icon indicates the middle point of the gradient from where the color
starts diffusing.

After selecting the middle-point icon, type a position-fixing digit in the
location box to fix the middle. The middle point can be shifted by dragging
the icon either to the left or to the right.

Adding and Removing New Color and Color Stops

[f more than two colors are to be used for a gradient, add new Color Stops to the
slider. To do this

Click anywhere at the bottom of the slider, and new Color Stop will be added
to the diamond for determining color blending middle point. In the same
way, requisite number ol Color Stops can be added to the gradient shider.

If any additional Color Stop is needed to be removed or cropped, click that
color stop icon and drag it to the outside of the slider. and the Color Stop will
be removed.
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Adjusting Brightness and Contrast of Picture

Pictures that have been scanned or
captured by a camera can be indistinct.
Visibility of color or black and white
can not satisfy the expectation level. In
that case, increasing the brightness and
combining contrast are required. To
increase the brightness and contrast

- Select the Adjustment command from the Image menu and get a submenu
from where click Brightness/Contrast, and the related dialogue box will be
viewed.

- By moving the triangle of brightness/contrast-slider in the dialogue box
either to the right or to the left. the brightness and contrast can be increased
or recduced.

- If any part of the picture is selected before coming of the dialogue box,
mereasing or reducing brightness and contrasting only the selected part can
be done by giving the command,

Activate the Preview check box in the dialogue box by clicking it, and the work
of the changing color can be viewed instantly. If the changed form does not seem
satisfactory, press the Alt button of the keyboard and the Cancel button of the
dialogue box will be changed into a Reset button. Keep pressing the Alt button
and click the Reset button, and the work previously done will be cancelled.

Hlustrator

Painting with Adobe Tllustrator: Adobe Tllustrator is the programme of drawing
pictures, illustrations, making logos and designs. Just as the scope of making
designs with Adobe Photoshop is limited, so is the scope of doing editing work
in Adobe Illustrator. The main job of Ilustrator is drawing.

Now, the artists of our country no longer use paint and brush for cover designing
of books. Thev design covers by using Adobe Illustrator. Invitation cards.
advertisements, posters, banners, bill-boards, efc. cannot be made without the
illustrator.

There are plenty of programmes in a computer for making designs. but the
Iustrator is popular for its facilities and varieties. That is why Illustrator is used
throughout the world.
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Apart from writing in the Illustrator programme by using a keyboard, writing is
possible as an artist does by using brush. The font size and shape can be changed
as required.

Like other programmes. open Illustrator and start making new files.

Open Illustrator Programme
To open Ilustrator programme

1.

4.

A menu will be viewed when you will click on the Start button at the left end
of the screen with the mouse pointer.

You will get a fly out menu placing the mouse pointer on All Programmes
in this menu,

By clicking Adobe Master Collection menu in this menu, you will get
another flv out menu. You will get the list of programmes of Adobe in this
MentL.

If you chick on Adobe [llustrator from the list, the programme will open.

To Open File in Hlustrator

Select the New command from the File menu or press Cirl N, and a New
dialogue box will be viewed. In the New dialogue box

Type a name in the Name dialogue

box, for example. Ankon-1. Any | s o -
name can be used instead of this phomy i
one. A name which is easy to o v g s
remember or compatible with the T M.

subject can be given. Finding out the e T T

file will be easier later on.

‘A detailed drop-down list will be viewed by clicking the drop-down arrow of

the size-box. Different sizes of the paper will be viewed here. The size ol
paper which is required should be selected by name, and the height and
width of the paper will be seen in the box.

The units of measurement are found in Units box. The users of our country
are familiar with the measurement of inches, but points, picas, millimetres,
centimetres, pixel, etc. can be used to work more precisely. Click the
drop-down arrow in the unit box. and a detailed drop-down hst will be
visible. The requisite unit of measurement can be fixed from this list.

Pictures of two people are viewed on the night of Onentation. If you click

Forma-13. ICT-9-10)
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the first one, the position of paper will be portrait, and it will be in
landscape position if the second one 1s clicked.

- Two options are shown as RGB and CMYK in Color Mode. CMYK mode is
suitable for printing work. but RGB mode is better for electronic medium.
However, on the computer screen, the difference of these modes are not
precisely distinguished.

- Fixing the measurement, press OK in the dialogue box, and it will
disappear. A new window will come.

In the Name box of the New dialogue box, type a file name, and it will be viewed
on the title bar at the right side of Adobe Illustrator above the menu bar. If any
file name 1s not typed “Untitled ...” will be viewed on the title bar.

Work Tools
New vacant files will be found on the screen after creating a new file. Numerous

objects like menu bar, toolbox. floating palette, scroll bar, ete. will be viewed for
starting worlk.

Title Bar

After opening the Illustrator
Programme, on the left-end above
the screen, the other information of
the document with the name of
application on the title bar may be
viewed, for example, Adobe
Nusirator-[Ankon-1 @ 70
(RGB/Preview)]. Here, Adobe
Illustrator is the name of
application, Ankon-1 is the name
of file if this name was given
during 1ts creation, and @ 70
(CMYK/Preview) is the size of visible area and presentation of color mode. The
entire part stretching to the right is the title bar.

- If any name 18 not given during opening a file, it can be given afier
completing and saving the work too. Files are given different names, and
when a file 1s opened, its name is viewed on the title bar to the right of the
application.
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Different kinds of tools and options for designing and drawing are arranged in
Toolbox & Palette. Designing and drawing can be done by using these tools
and options, and editing work is possible 1o get the image in its expected form.

Names of the Necessary Tools of the Toolbox

Names of the necessary tools should be known before starting work. Ellipse,
polygon. star, and spiral tools stay on the linear position in the toolbox. These are
called "Group Tools’. A Right-angeled triangle is attached with these tools, If a
triangle sign is attached with the tool, it means that more tools are kept in the
same position. If you click the visible tool in the box and continue pressing the
mouse, all the tools will be viewed together. Drag the mouse pointer on the
required tool and click, and the tool will be visible in the toolbox.

There are some icons in the swatch below the tools in the toolbox. Imposing
color in an object or on the edges of an object or cancelling a command can be
done with these icons. Create an object to understand the use of the icons. To
make an object like this—

Toggle column — Zo

(V) Selection Tool [ | &, Direct Selection (A)
()magicwand K & Lasso(Q)
PyPen & T, TyeeM
(VU Line Segment N, &, Rectangle (M)
() Paintbrush & JF,  Pencil (N)
(R)Rotate ), B3 Scale(S)
shitt+ Rywrap L K3 Free Transform (E)
(Shitt+5) Symbol Sprayer :I;__H, Column Graph (J)
(uyMesh @3 (M Gradient (G)
(1) Eyedropper ¥ 9, Blend
(K) Live Paint Bucket <% & Live Paint Selection (Shift + L)
{Shift + D) Crop Area 3, &7, Eraser (Shift+E)
() Hend 4, A Zoomiz)
00 Toggle till —p ot Swap fill/stroke (SIft+X)
(D) Defautt fill/stroke — almsl<—— Toggle Stroke (X)

(<) Calor C @ Z<— None (/)

(=) Gradient

Change sreen moda (F)
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- Click the rectangle tool with the mouse pointer, and the tool will be selected.

- Bringing the mouse pointer inside the screen, and after clicking elsewhere
drag diagonally right below for an inch, and release the finger pressure
from the mouse. A rectangle or square object will be created.

- The object will be selected and filled with a color.

- Four hollow boxes will be viewed on the four cormers of the selected
object. Four small solid boxes will be viewed on the four corners,

- If the object becomes free [rom the selection, click Direct Selection Tool in
the toolbox with the mouse pointer, and the Direct Selection Tool will be
selected. Now bringing the mouse pointer inside the screen, click the object
with Direct Selection Tool, and the object will be selected. In this situation,
again click the Selection Tool, and four solid boxes can be viewed on the
arms along wiih four solid boxes on the comers.

Filling Color on Object

Fill and Stroke

- The edge or border of an object is
called *Stroke’ and the internal part 1s
called the *Fill’. The use of the “Fill’
and ‘Stroke’ swatch is related to the
color palette. Il the color palette 1s not
viewed on the screen, either give the
Color command from window menu or
press the Fé6 button, and the color
paletle will be visible. Click the Fill
swalch and 1t will be activated and
viewed above, Thus only the work of
[illing can be done. Only an object can
be filled, not the stroke. Similarly,
clicking the Stroke swalch, activate it
and stay over the Fill swatch. Thus, color ¢an be imposed on the strokes of
object. It will be impossible to fill object with color from here.

BT ICNONEW RO /o)
E :Q FXAFWE L":ﬁ}.l.rii-r‘!-l

- When the Fill swatch is active, click on the colour of Color Spectrum Bar of
the color palette. The inside of the selected object will be filled with that
color. Similarly, when the stroke swatch 1s active and the color that will be
clicked on the Color Spectrum Bar, the strokes of the objects will be filled
with that color. The color mside the object will remam unchanged.
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Stokes can be thick for a clear view. For having this eflect, select the stroke
command from the Window menu, and Stroke palette will be viewed on the
screen. Select at least 10 from the weight drop-down menu in the Stroke
palette. In this stage, if color 1s imposed or changed, it will be clearly visible.

Color, Gradient, and None

Color, Gradient and None are the three icons respectively S K
below the Fill and Stroke swatch. Clicking Color and -
Gradient icon separately, activate the Color and Gradient %
palette. Click the None icon, and the fill of selected object or [

the color of stoke can be inactive or cancelled. It an object is 1 N
filled with color or gradient, the color will be viewed. If the
object is selected, the color will be changed as well.

Increasing and Reducing the Size of Object

284

Many minute jobs are done to create object. Doing these minute jobs may be
troublesome in the usual size of the object. If a specific part of the object 1s
enlarged. it [acilitates the task. Viewing a page in an increased size while
working in Illustrator is called Zoom in, and in decreased size is Zoom out,

Object will also be viewed either big or small with increasing or decreasing size.

To view an object big or small, the visible size of the page will be made big or
small by using Zoom Tool. To get the job done

The Zoom Tool will be selected, if it 1s clicked in

the Zoom Tool box. f %{
Fl ol

After selecting the Zoom Tool, if the mouse
pomter 1s brought on the screen, it will look like a q'iﬂp q
flint-glass, and a plus (+) sign will be visible in ——
the glass,

The size of the screen will be bigger when clicked with the Zoom Tool on
screen. With the increasing size of the screen, the object will remain on the
screen enlarged. If it becomes enormously enlarged, some objects will not be
viewed on the screen. Clicking on the screen and dragging with the
hand-tool, that part can be brought on the screen.

Press the All button wlale the Zoom Tool 1s active, and the Zoom Tool will
be transformed into the Zoom Out Tool. Keep pressing the Alt button and
continue clicking with the Zoom Qut Tool, the size of the screen will
gradually become smaller.

Press Cirl - or Ctrl = button to complete the work of Zoom out and
Zopom in.
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Changing the Positioning of Page By Hand Tool

If the size of the page is made smaller or bigger, the necessary part of the object

can go outside the visible area. In this case, to shift the object to a suitable place

on the sereen

- Select the Hand Tool by clicking on it in the Hand Tool Box.

- Click on the necessary object with the Hand Tool, dragging it to a suitable
place, and release the pressure of the finger on the mouse.

In this way, the positioning of the original page can be changed. The object

that has been clicked will not be shifted in a different way.

Mode of Viewing Object

There are some modes to view objects in the Illustrator programme. Any of these

can be selected from the View menu as required.

- In Outline Mode, the object is viewed as an outline or in a linear shape, In
this mode. editing of the shape or structure of the object, particularly a
detailed editing of a line or path can easily be done.

- The object is viewed perfectly in Pixel Preview or Preview mode.

- The image viewed in Overprint Preview Mode can be printed out.

Creating Object

In the preparatory stage of creating objects, the elementary process of making

different kinds of shapes should be leamnt, for example, squares, rectangulars,

circulars, and elliptic, multi-angular, starry, and spiral shapes. To create an object

- The Rectangle Tool will be selected if clicked with the mouse pointer.

- After bringing the mouse pointer inside the screen and clicking anywhere,
drag diagonally below an inch and release the pressure on the mouse. A
square or rectangular object will be created.

In the same process, select another object tool from the Tool box and make other
objects. No object can be created only once. By erasing the object partially or
fully, we can start in a new way. To get the task done, it is required to learn how
to erase the entire object or part of the object.

Selecting Object and Erasing Borderline or Path
- Ifthe object is filled with color, the object will be selected if clicked with the

Selection Tool or Direct Selection Tool. Keep pressing the Alt button and
click on the path of the object. The entire object will be selected.

- To erase the path of the object or the part of the path, select them with erther
the Selection Tool or Direct Selection Tool. Press Backspace or Delete
button, and the Path or the part will be deleted.
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If the Backspace or Delete button is pressed, the object is erased. Select the Cut
command from the Edit menu, and the object goes to a femporary memory called
clipboard and stays there until another object is cut or copied. When an object
stays on the clipboard, selecting the paste command from the Edit menu will
restore the object to the document.

Path
The path of the object can be formed with more than one segment. A single

segment can also be used if necessary. The border of the object is called Path.

A straight line 1s called Path too.

Selection Tool

- The selection Tool, Direct Selection Tool or Group Selection Tool can be
used to select either the entire abject or a part of an object.

- The selection tool is called the Black Arrow. Click the Selection Tool with
the mouse pointer for using the tol, and it will be selected. 1f the mouse
pointer 1s brought on the screen afier selecting the tool, the mouse pointer
takes the shape of a black arrow or selection tool. Click on the object and it
will be selected. Selection Tool is also used to select the entire object.

- If any object is selected with the Selection Tool, rectangular, circular or
bounding box is created around the object. Four hollow boxes on four
corners and four on the four arms will be visible. These boxes are called
Resize Box. Clicking and dragging on the resizing boxes, the size of the
object can be enlarged and reduced. Keep pressing shift and drag, and the
object will be bigger or smaller according to proportion.

- Clicking the centre of the selected object with the Selection Tool or on any of
the arms or any part of the object and dragging, it will be shifted to anywhere.

For selecting more than one object together

- After selecting the first object, keep pressing the shifi button and select the
next object. In this way, sclect as many objects as required. When all the
objects are selected only one bounding box will square them.

- By clicking and dragging the resize box of the bounding box, all the objects
will be enlarged and shortened together.

- Click the mouse pointer on an empty space on the screen, the object will be
selection-free. If any particular object requires to be selection free from
numerous selected objects, click the object while pressing the Shift button.

Direct Selection Tool

The white tool on the right of the Selection tool is called the Direct Selection

Tool. This tool is called the White Arrow.
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The Direct Selection Tool or the White Tool is used Lo select the segment of the
object or the entire object. A part of the object can separately be enlarged or

shortened by selecting any anchor point of the object with the Direct Selection
Tool.

Grouping Object

To create a group of abjects

A. Select etther all or requusite objects.

B. The selected objects will be grouped. if the Group command is given from
the Object menu.

Clicking on a blank space, make all the objects selection-free, and then click any

object with the black arrow or the selection tool, and a rectangular boundmg box

will be created around the grouped objects. Thus the objects inside the selection

box will be selected together.

To make the grouped objects ungrouped:

A. Click an object. and the grouped objects will be selected.

B. Give the Ungroup command from the Object menu, and the grouped objects
will be ungrouped,

Lock the Objects

While working with more than one object, it is required to keep one or more
than objects locked. As a locked object can not be selected, the editing work can
not be done. So the locked object can not be changed by mistake.

To lock an object:

A. Select a particular object.

B. Give the Lock command from the Object menu.

If' it 1s required to edit or change a locked object, unlock it. To unlock an object

select the *Unlock All” command from the object menu. Thus all the objects will
be unlocked. An unlocked object can be ediled in the usual way.

Use of Cut, Copy and Paste Command

After selecting any object with the selection tool and giving the Cut command
from the Edit menu. the object will disappear and it will be copied if the Copy
command is given. Any cut and copied object is stored on the clipboard, and if
Paste command is given from the Edit menu. the object will be pasted on the
screen. The object can be shifted elsewhere by dragging it with the selection
tool.

If any object 18 dragged while Pressing the All bution of the keyboard, it is
shitted after a copy is created.
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Grive the Paste in Front command, and the object will be placed above the

existing object.

Give the Paste in Back command, and the copied object will be placed below the

existing object.

Laver

Layer means step. In this process. editing can be done while keeping different

objects on different steps. This layer or step can be compared (o transparent glass

or polythene. If three objects or pictures are created on three glasses or

transparent media and placed on the other, three objecis will be viewed. These

three glasses or media are regarded as layers.

The facilities of working in the layer process are as follows:

e Arranging steps among the Layers;

e keeping more than one layer invisible;

e keeping layers locked;

e Adding a new layer. removing unnecessary layers, etc.

Creating New Lavers

IT Layer palette is not viewed on the sereen, give the Layer command from the

Window menu, and the layer palette will be viewed. At the beginning, only one

layer will be on the palette. After finishing the work of a layer, add a new layer

on the paletie to create new object. To add a new layer

A. A new layer will be added on the layer palette when you click the Create
New Layer icon below the row of Laver Palette.

B. If any layer numbered serially needs to be identified with a particular
name, double-click the layer and a dialogue box called Layer Options will
be viewed. Tvpe the necessary name on the Name box, and click the Ok

button. The serial number or name of the concerned Layer (if the name was
previously given) will be changed into the name typed in the dialogue box.

Cancelling Layver

A. By selecting the Layer and the Delete command from the pop-up menu on
the layer palette, the selected layer will be cancelled.

- In the process of deleting a layer of artwork or an object. a cautionary
message like ‘Delete Laver?” will be viewed. Click the ‘Ok’ button. and the
layer will be deleted. Click the “No” button, and the deleting process will be
stopped. But by clicking and dragging the layer, on to the Delete icon. no
such message will be viewed.

Forma-14. ICT-(2-10)
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Merging Layers

After creating and editing objects of two or more layers, they can be merged

together. To get the job done:

A. Select the layers.

B. Select the *‘Merge Selected” command from the pop-up menu of the layer
palette, and the layers will be merged.

Use of Color in Object

After creating an object, fill in the color as required. The color palette, color bar,

or color spectrum bar, gradient, etc. are used to fill color in the object.

Color Palette

If the color palette is not viewed on the screen, give the color command of the

Window menu, and the color palette will appear.

- On the left above the Color Palelte, an
indicator box of Fill and Stroke or
Swalch is found. Color Slider and Color
Spectrum Bar are found below 1t. It the
work 1s done on gray scale mode, only
one color slider will be viewed. I[ the
work 18 done on RGB = Red Green Blue
made, 3 color sliders will be viewed, and
if the work is done on CMYK mode, 4
color shiders will be viewed.

Fill Color

To fill color in any object:

A. Select the object.

B. Click the Fill Indicator box of the
Color Palette, activate il. The
activated Fill Swatch will stay
above the Stroke icon.

C. Click the requisite color in Color Spectrum Bar.

- The selected object will be filled with the color in Color Spectrum Bar. On
the extreme right ol the Color Spectrum Bar, a Swaich of black and white
color will be found. If the black swatch is clicked, the object will be filled
entirely with a black color, and if the white swatch is clicked, the object will
be filled entirely with a white color.
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The Use of Stroke

The border of object is called Path. The measurement of making a path thick or

thin 1s called Stroke, Objects of grouped and ungrouped path, straight. curved

lines, etc. are controlled by Stroke. Controlling strokes means to make a path
thick or thin and colored. Making a Stroke thick and thin can be done with the

Stroke Palette. To get the job done

A. Select the object or path. If the Stroke Palette 1s not viewed on the screen,
click the Stroke command from the Window menu, and the Stroke Palette
will be viewed.

B. When the object or path remains selected. click the downward arrow of the
Weight box in Stroke Palette and keep pressing the mouse, many
measurement units will be shown in the dropdown list. Select a number from
the list as required. If a small number 1s selected, the stroke will be thin, and
if a large number is selected, the stroke will be thick.

C. A measurement unit can be typed
directly i the Weight box, if il e RS
required. The fraction of a number weist@: b e
can be used too. The thickness and
thinness can be determined from
0-1000 points.

Pen and Pencil Tool

The main reason of the Illustrator programme being popular is the use of Pen
Tool. It is possible to make complex and very small design and do the editing
work with the Pen Tool.

Two anchor points are found at the two ends of a path or line. The first anchor
point is called the starting point and the second anchor point is called end point.
There is a controlling handle with the anchor points of curved path and a
control point outside the control handle. By clicking and dragging the control
point, the curve of a line can be controlled. The anchor point, control handle. and

control point are not viewed in the print out.
The Pencil Tool is another form of the Pen
Tool. Curve lines cam be made by
dragging the Pencil Tool. 2
The Pen Tool is the main lool for drawing v S Y /
veclor objects. A subtle object can be //
created by a keen path with the help of the

Pen Tool.
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Closed Path and Opened Path

A closed Path has no beginning and no closing point, as in a circle and square,

etc. A closed path may have curved ends. On the contrary, an Open Path has a

beginning and a closing end.

Pencil Tool and Pen Tool

A Path can be created easily with the Pencil Tool. By selecting the pencil tool

from the tool box, and clicking and dragging it on the screen path, a drawing

curved line is possible. The function of the pencil tool is like making a sketch on

the paper. On the conirary, a path 1s created with the Pen Tool by clicking and

dragging. To make a path with the Pen Tool

A. Select the pen tool from the toolbox. Chick anywhere on the screen and
release the pressure of your finger from the mouse,

B. Click a little bit above lor the second time and release the pressure of the
finger from the mouse.

C. Click on the right below from the place where you have clicked for the
second time.

D. Click above the right a bit, and drag rightward.

E. Click on the right a bit below, and click again on the right from the position
of next, moving a bit rightward from the previous click.

F. Clicking on the right above and drag further right from this position

G. Click on the right below.

A wave-like open path object can be created m this way.

Editing Path

A path cannot be created according to the expectation at the first attempt. After

creating the path, give it the expected shape through editing. By editing the path,

new anchor points can be added, and it can be removed if required or Cropped

up or the two separated parts can be connected too. In this way, a change can be

made as many times as required.

Adding Anchor Point e N,

To add an anchor point at any point of the path: '

A. Select the Add Anchor Point Tool from | /
toolbox, and bring the mouse pointer
inside the screen, a plus sign (+) will be found on the right below the Pen Tool.

B. Click any place of the path with the Anchor Tool Point, and a new anchor
point will be set on that point.

- The new anchor point added on the straight path is called a Straight Comer
Anchor Point and on the curved path is called a Smooth Anchor Point.
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Removing Anchor Point

To remove any anchor point on the path:

A. Select the Delete Anchor Point Tool. After selecting the tool, bring mouse

pointer inside the screen, and a minus sign (-) will be viewed below the Pen Tool.

B. If vou click any anchor point with the Delete Anchor Point Tool, that anchor

point will be deleted.

Editing Cuarve Path

A circle/rectangular object or a design will be created with the pen/pencil tool

for editing path. To edit curve:

A. Selecting the Direct Selection Toel and after elicking an anchor point, drag
and shifi its position, and the curve and shape of the anchor will be changed.

B. Click an anchor point. and the handle of it will be viewed. Clicking and
dragging the conirol point of any end of the handle, the part of the path
related with the anchor point, and the curve can be reduced or increased. The
direction can be changed too.

After creating open path with the Pencil or Pen Tool, the strokes can be thick or

thin, and filled with color. After creating closed paths with the Pencil or Pen

Tool, 1t can be filled with any color.

Writing Job

Writing is mandatory for the covers of books, magazines, posters,

advertisements. cards, etc. The Type Tool 1s used for writing in ustrator, Six

kinds of Type Tools are found in Tllustrator. Arrangement of writing can be done

in three ways with these Type Tools, for example, Point Text. Area Text and Path

Text.

Point Text

Inthe Point Text process, the way of typing is very easy. To type in this process:

Select the Tvpe Tool from the toolbox.

Click any blank space of the screen.

Change the keyboard into Bangla for typing in Bangla.

Click *Character” in ribbon on the screen, and the Character Palette will be
viewed. Select the font [rom the Fonl Pop-up menu of the Character Palette.
Start typing following the rules of word processing. Click any letter with
the Selection Tool. and a line will be viewed below it. This line is called
‘Baseline’.

Editing Writing

The requisite commands will be found in the Type menu and in the Character
Palette.

Cawr

(
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Select the Character from the Type command of the Window menu, or press Ctrl
T, and the Character Paletie will be viewed floating on the screen. When it is
floating, it can be used as required.

Selecting Letters

Letters, and words can be selecled according to the m
rules of word processing while the Type Tool | S=ritfses x
is selected. Click with Direct Selection Tool in mg\fh_r_ SR R
the writing, the entire typed part ie. the entire | & = &~ = Eee -
writing with the baseline will be selected. In this St o R
case, the letters will not be highlighted. The | & 0% - [IT: e -
baseline under the letters will not be viewed. e N
Changing Color of Letters s i

To change the color of the letters: e

A.The requsite letters or wrnitings should be selected.

B. Click on the color on the bar of the Color Palette or Swatch Palette. The
selected letters or words will assume the color.

Deleting Letters

A letter or letters or a paragraph or the entire writing can be deleted by pressing

the Backspace/Delete button, il it is selected.

Enlarging or Reducing Font Size

A. Click the downward arrow on the right side of Font Size box in the Character
Palette as the letier or letlers are selected and keep pressing the mouse, and a
List of measuring numbers about the Fonl Size will be viewed. Continue
pressing the mouse and take on a measurement number, and the number will
be selected. After giving the command, release the pressure on the mouse
and the size of the selected letters will either be enlarzed or reduced.

B. If the requisite measurement number is not found in the drop-down menu,
place insertion pointer in Font Size box by clicking directly.

- By pressing the Backspace button, delete the existing measurement number
and type new number.

- Press Enter bution and the selected letier or letters will either be enlarged or
reduced according to the measurement number.

Increasing or Decreasing Font Size Vertically and Horizontally

To get the job done:

A. Click the drop-down arrow on the right of Vertical Scale and keep the
pressure on the mouse to get the list of measurement numbers. If a number
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bigger than 100% 1s selected. keep the pressure on the mouse and drag. The
font size will be vertically big. On the contrary, if a number smaller than
100% 1s typed, the font size will be vertically small. 100% is the ideal
measurement of letter.

To increase or decrease fonts horizontally:

B. Clicking the drop-down arrow on the right of Horizontal Scale and keeping
pressure on the mouse to get the list of measurement number. If' a number
bigger than 100% is selected, keep continuing the pressure on the mouse and
keep dragging. The font size will be horizontally big. On the contrary, if a
number smaller than 100% is typed, the font size will be horizontally small.
100% is the ideal measurement of letter.

Baseline Shifi

If any text written with the Direct Selection Tool is selected. the line seen below

the text is called the Baseline. Shifiing the lower edge of the text up or down 18

called Baseline Shili.

Selecting the measurement number from the drop-down menu in ‘Set the

Baseline Shift box™ of the Character palette, or typing measurement number

directly in the Set the Baseline Shift box, the measurement of Baseline Shift

should be fixed. The use of a negative number will take the text below the
baseline, and conversely an positive number will bring the text above the
baseline.

The Leading

The space between the lines is called the ‘Leading” which can be required for

the text containing many lines,

A. By selecting a measurement number from the drop-down menu in Set the
Leading box of the Character palette, or typing the measurement number
directly in the Set the Leading box, and pressing the Enter, the Leading will
be activated.

B. If the upward arrow button of Set the Leading box is pressed, the
measurement ol the Leading will increase, and if the downward arrow button
1s pressed, the measurement of the Leading will decrease.

Area Text

Any text typed or placed in square, rectangular,

circular, elliptical or any closed path is called Area

Text. To type or arrange text in a closed path:

A. Creale a square, rectangular, circular or
elliptical path.

B. After selecting the Type Teol, place the
mouse pointer on the closed path. the Type

20
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Tool will take the shape of the Area Type Tool.

C. Click on the anchor point of the path, and the insertion point will be placed
inside the closed path, which will be used as a Text Box or Text Container.

D. Start the work of typing.

E. When you will reach the right edge ol a line, the inseriion pointer will
automatically go down the next line. If typing continues in this way, the
next line will be automatically started.

Typing in the Path

Typing inside and outside the closed path, and below and above the open path

can be done with the Path Type Tool of Illustrator. Typing inside and outside a

circular object like making a monogram can be done.

Typing outside Circular Object

A. Make a circular object, and if it s filled with color, click the None icon either
of the Color Palette or Tool Box to delete the color of the circle.

B. Select the Type on a Path Tool from the Tool Box

as the circle is selected. Click the anchor point of P = T

this cirele with the tool, and the msertion point will Eﬁ" ‘%

be placed outside the Path of the circle. ) A
- The circle must be selected while clicking. I it is % g

not selected, step 1 and step 2 should be completed

after the selection.

If typing is started, the text will advance following the path of the circle

usually from left to right. In the same way, the text wall be arranged outside

rectangular object if required.

D. Click the text with the Direct Selection Tool and the Eyebeam between the
Path and the text will be selected.

E. By clicking the edge above or below the Eyebeam and dragging it n a
circular way the text can be shifted elsewhere.

Arranging Writing in Open Path

A. An Open Path can be created with the Pencil or Pen Tool.

B. Click on the selected Path wath the Path Tool, and the insertion pointer will
be placed on the Path. _

C. Type following the usual rule. Ut @#‘3'

- The Path and the Text will be selected | £ Rty oy g TS
if the text is clicked with the Direct

0
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Selection Tool, and the text can be shifted elsewhere by clicking and dragging
the Eyebeam while selected.

- The Path will be selected if chicked with the Direct Selection Tool, and the
anchor point of the Path will be viewed. Now the Path can be edited
following the rules of editing. If the Path is made curve, the text will follow
the line.

- If the Path is smaller than the text, any additional text will not be viewed.
When the Path will be extended, the rest of the text will be viewed.

Creating Outline of Letters

When the outline of letters is created, the edges of the letters will be transformed

mto a Path. By clicking and dragging the Path and Anchor point, the shapes of

the letters can be changed.

. 1 ' s .l"'."ﬂ.l" = “-\"- . = Tty e,

T'o ereate the outline of letters: == D) @wﬁ YT Lo

A. Select one or more than one letter | Y T L W0 7§ I
or word.

B. Give the Create Outline command from the Type menu or press Shift Ctr] O,
and selected text will be transformed into the Outline.

When the letters will be transformed into the Outline, the text will be changed
mmto graphics. The shape of the letters can be changed following the rules of
editing a Path, filling color and adding gradient.

Placement of Image in Hllustrator

To place an image in illustrator:

A. Give the Place command from the File menu and a Place dialogue box will come.

B. Select the required file from the Place dialogue box.

= It should be known in which folder and under what name the file has been saved. The
required file will be selected after opening the specific folder.

€. Click the Place button in the dialogue box, and the image of the selected file will be viewed
on the screen.

- A cross sign will be viewed on the image when the image of the Photoshop is placed in the
Ilustrator. Click outside and the cross-sign will be removed. Click the image with the
Selection Tool, and the image will be selected and four resize boxes on the four arms and
on the four angles will be viewed. By chicking and draggmyg the resize boxes, the images
can sither be enlarged or reduced.

Group work
« Edit any image using Photoshop.
» Draw a monogram for any school in Tllustrator.

Because of the version of software there may be diiference in title and menu bar.

Farma-15, TCT-(9-10)
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Exercise
1. How many forms of media are combined in multimedia?
Al B 2
C.3 D. 4

I3

In which work is multimedia used?
A. For preparing an examination result; B. For calculating shopping expenditure;
C. For preparing a scoresheet of cricket; D. For making an animation {ilm;
3. Which one is a multimedia Software?
A. Microsoft Work B. Microsoft Powerpoint
C. Microsoft Excel D. Microsoft Access
4. Application of Multimedia -
t.  has made the presentation of text impressive;
1. has made the work of printing and publication easy;
iii. has made the keeping of accounts easy;
Which one is correct?
A.1&1u B. 1&m
C. 11 &1 D. 1, i & il
Read the chapter below, and answer the guestion nos. 5 & 6:

Mr. Rakib is the chief executive of a renowned company. A foreign delegate
will come to visit his company tomorrow. He has made a presentation in his
laptop and he will show it to them. He took the help of a piece of Software for
the presentation.

5. Which Software is suitable for Mr. Rakib for his representation?
A. Microsoft Word B. Microsoft Powerpoint
C. Microsoft Excel D. Microsoft Access
6. The Software which is used by Mr. Rakib—
1. will make the presentation impressive by using animation.
ii. will show the activities of the company by using sound and video.
ii. will prepare the accounts of his company.
Which one is correct?
A i1&il B. i&iii
C. 11 &ii D. 1,1 &iii
7. Explain the importance of Presentation Software to present anything.

8. ‘The present publication industry is completely dependent on Graphics
Software,’ explain with reasons.



Sixth Chapter

Problem Solving through Programming

After completing this chapter, we will be able to........
# understand problem-solving;

» learn about programming languages;

» code using the Python programming language?

» solve common problems using the Python programming language.

Programming in problem solving

In real life, we encounter various types of problems. We need 1 solve these
problems to move forward. Problem-solving is the process of identifying chal-
lenges or obstacles to understand the nature of the problem and find ways to
overcome it. This involves analyzing the surrounding circumstances, thinking
critically, and discovering possible solutions to the problem. This process typi-
cally includes defining the problem, considering potential solutions, evaluating
those alternative solutions, and then implementing the best solution,

L TEHL R L
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Programming Language

We use various languages to express our thoughts, such as Bengali, English,
French, Latin, Spanish, etc. However, a computer cannot directly understand
these languages. To give any instructions to a computer, we need to write them
in a language that the computer can understand. Computers and any electronic
devices can only understand 0 and 1.

=
=
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But writing our instructions using only 0 and 1 is challenging for us. The
languages we humans typically use are not composed solely of Os and 1s.
So. how can we communicate with computers? There are certain languag-
es where, by following specific rules, we can write mstructions that the
computer can easily convert into a form it understands. These languages
are known as programming languages. There are many types of program-
ming languages, such as C, C++, Python, Java, and so on.

By learning any programming language, we can give various instructions
to the computer as needed using that language. In a software apphcation
on our computer, we will first write the instructions in a specific program-
ming language. The computer has a translation system that converts these
programming language instructions into machine code.

HELLO 010110

P
[T

What is machine code or machine language?

Machine code or machine language is essentially a binary code made up of 0 and

1, which our computer can directly understand. Therefore, the task of translating

between programming languages and machine code is done with the help of a

type of program called a translator. By converting instructions into machine

code through a translator, the computer can understand our commands and com-
plete the specified tasks accordingly.

The translation system or translator program in a computer for programming

languages can be of two types:

a) Compiler: In some translation systems, if all the instructions we give are
correct, they will be converted into machine code all at once. This translation
process is called compiling, and the soliware that performs this translation is
known as a compiler.
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However, if the corapiler finds any errors in the entire set of instructions, it
cannot proceed with the translation. Only when all instruetions are error-free
can the compiler perform the translation.

b) Interpreter: In some translation systems, regardless of the number of instru
ctions we give, they will not be translated all at once. Instead, each mstruc-
tion will be translated sequentially, one by one. This translation process is
called interpreting, and the program that performs this translation is called an
interpreter. The interpreter translates each instruction one at a time and will
stop if it encounters an error in any instruction.

Innguage Campiler Miuchine Code

Go to The Next
Command

Which Programming Language to Learn?

To start, learning any one of the commonly used programming languages is
enough. This is because the basic structure of all programming languages is sim-
ilar, with only slight differences in the way instructions are written. For exam-
ple, in the C programming language, each statement must end with a semicolon.
but in Python, this is not necessary. Though there are some differences, there's
no need to worry. Once you leamn one programming language, it becomes much
easier 1o learn others. Generally, the choice of a programming language depends

2023
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on the type of work and to some extent on personal interest. For those new to
programming, Python can be an excellent starting point. Python is a fun and
beginner-imendly pmgl'ammmg language

with simple syntax, and it is widely u.‘,ed n ﬂ p U t h 0 n
fields like web development,

science.and automation.

Starting the Journey of Programming in Python:

To write instructions or code in Python, we need to perform some tasks to set up

the programming environment:

1. We need to download the Python application and install it on our computer.
Python can be downloaded from this link.

https://www.python.org/downloads/

Afterthat, we download the latest version from there.

2. Once the application 1s downloaded, we proceed to install it. During the
installation, we will see a window like the one below:

Sh Biren G127 B4 bR Arng

J Install Python 3.12.7 (64-bit)
- bt Igta Bem §6 adal Bptfumn mith Safhult inthngs & Shose

Customae io erabie o dissbie eiture

python

windows

[T it s ol wilian sl g By wasm
[ Al pryt e s 1 AT Carce

Click the options at the botiom of the installation window and check the boxes.
Then, I will click on the Install Now option. If it asks for permission to install. [
will grant that permission as well.

3. After that, we will see a message indicating that our sgtup was successful.

4. Python is now added to our computer. However, we will need another soft-
ware application where we can write our instructions and communicate
them to the computer. For that, let’s go to this link: https://www.thonny.org/.
from this link, we can download and install the thonny software.
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5. Afterthat, open the Thonny software. We will see a window like the one

below.

When clicking the button, Let's go! a window like the one below will appear.

¢

- o b

Ergiech (L) [chefaum]

iteal coftailage .‘.'r_l.ll'\:dil d

Lenguusge

Let's go!

Th Mioney - sumitied= § 11

Fle Edit Vew Pum Took Help
JSd Ow -
= bt =

1

Lovesd Pgiion § « Thawny's Pythos =
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6. Let’s understand a few important sections in this window:,

T Thorey - <untitied= @ 7:1
Fie Edt YVipw Fun Tooh Help
15 O® -

‘ |—D To see the output, click here

To save the programme, click here

= o o

Hezre goes the prograrmme name
{Space to write code)

Here the output of the code is shown

Loetal Pyiios 3 = Thasiryy's Pyihon &

7. Now let’s write a programme which will print Hello World! as the output.
The print() function is used to print something as an output. The text we
want to print should be written within the print() function with ' ' (single
quotation). So, to print Hello World! we have to write:

print (" Hello World! ")
Now clicking the ‘Run’ button will show Hello World! as the output.

‘ Thormy - CAlhanrmdme’Hella Weddgy @ 1: 20

- =] x
File [de Vew Run Tooh Help
Jd & O - =
e Wierld py Lonegiwest

1 print ("Hello World! ™)

Shesll

E
Mallo Worldl

>¥¥

Lol Pyshan § = Thosery's Python =

8. Now we will click on the save button and save the file with a name of the

programme. Then our file name will also be displayed on the top of the
programme.
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To Show Text

Just as we printed English text, we can also print Bangla.
Let's write down the following line and run it and see what happens:

print(" =i AT SR )
So, the print() function prints definite texts on the monitor screen or other standard
output devices. The message may be a string or any other object. Before appearing on
the screen, the object will transform into string.

Using Variables in the Programme (Variable)

To store any information within a programme, we will use a
variable. A variable is like a box within which certain infor-
mation can be stored. The word variable means inconsistent.
That is, if we want, we can store a piece of information in one line of the programme,
then change that information in another line and store another piece of information. It
may be noted that in Python it 1s not necessary to cite the data type of a variable. Even
after setting the data type, it can be changed any time.

Naming the Variables

We all have a specific name, and everyone can recognize us by that name. Similarly,

each variable also has to be given a specific name, with which we can recognize and use

the vanable throughout the programme. For example. if we create a vanable called

number where we want to deposit 9 as the value of the variable. Then we will write -
number =9

There are a few things to keep in mind when naming variables:

1. The name of the variable will always be a word. That s, we cannot write the name
ofthe variable with more than cne word. However, if you want, you can exclude the
spaces between the two words and give them the name of the variable as a word.
Again, the variable can also be named with an underscore ( ) sign between two
words, omitting the space between them.

2. The first letter of a variable's name must be a-z or A-Z or underscore (). The first
letter cannot be a number (0-9) or any other symbol (e.g. * or etc.). However, after
the first letter, any number (0-9) or a-z or A-Z or underscore () can be used as the
remaining letters.

3. No other symbols such as @, §, %,A, etc. can bs used in the name of the variable.

Forrnn-16, ICT-{2-10)

'

)
oy
o]
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4, Python is a case-sensitive programming language. So, il the same letter is
lowercase and uppercase, Python will treat them as two different variables.
For example, My variable and my_variable will be treated as two different

variables.

5. Keywords are saved words in Python programme. We cannot use keywords
as the name of variables or functions or any other identifiers. In Python 3.10,
there are 35 saved keywords. For example, False, True, None, and, as, break,
class, continue, if, else, except, while, return, for, global etc.

Incorrect naming of variable Correct naming of variable

My Variahle MyVariable or My Variable

National 1D NationallD or MNational ID

this variable is cool this variable is cool

z!lyan zlyan Or z yan

Qabe abc9

$variable ~variable

My name My name

print Keywords cannot be used as variable names.
But Myprint or printl is correct.

Storing or assigning data to variables
We use = symbaol to store data in variables. This is called assigning value.
Suppose, we have a variable *age’, Now, if we want to keep the value of age 235, we will write

in the programme: value,
ape=15
If we want to print this value then we have to write:
print (age)

Now if we write and run the following programme Assignment

age=25

: age = 25

print (age) e
Variable — — Value
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Then we will get output like the following

ﬂgu'I:E: L. . W Thivmy = vigibilinds & 101
Again, it is possible to change the value of 2 s s v B st 4l

variable multiple times throughout the Jod 0% ¢ =
programme. When a new value 1s assigned to il
ages s

the variable, the previous value is deleted and print (age)
the last assigned value is stored. 1T we run the il
following programme, what will be the

output?

Shall
value now=1 ==
print(value now) "
value now=2 »)
print(value now)
value now=3

print(value now)

Let’s write the output of this programme in the box below.,

1
2
3

Notice that in the above programme, we have printed the same variable
value now again and again. But as each time the data stored in the variable was
different, we gol dilferent values aller printing them.

Data Type

As we know, the computer processor has to work with whole numbers. fraction-
al numbers. letters. words boolean or logical data etc to process the data. A data
type usually defines how much memory (bits or bytes) a piece of data occupies
in computer memory and describes how the processor processes the data. There

are different types of data types in Python programme. Some Data types are
mentioned below.

a) int: Whole numbers are called integer numbers in English. So, il whole num-
bers are stored in the variable, its data type is called int. Here int is the short form
of integer.

One such example 1s:

Empld no=35

2023
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b) float; In this variable we can store fractional numbers. Such numbers are
called floating numbers in English. Therefore, if fractional numbers are stored in
the variable, its data type is called float. One such example is:

Age=45.50

¢) str: If we want to store any text or textual information in the variable, then it
is called string. And such imformation is included in str datatype. Here str is the
short form of string. We have to put the text we want to put in the string variable
inside single quotation marks. For example:

a='c'
b="This is a string variable’

d} bool: bool 1s the abbreviation of boolean. If True or False is 1o be stored as
data in a variable, then it will be boolean data. Only two information can be
stored in bool data type: True or False. One such example is:

a=True

Python programme has other datatypes besides int, float, str and bool; we will
know about them if ever needed while writing a programme. The data we store
in the variable is stored in the computer's memory. So, when we use the variable
somewhere in the programme, the value of the variable stored in the computer
memory will be used.

Change of Data Type: Type Casting

The data type of a variable can be easily determined using type(). If we print a
variable inside the type() function. we will get the datatype of that variable.

For example. 1f we run the following programme:

teal variable= 73.07
prinr (test variable)

print{type(test vanable))

We will get the following output:

73.07

=rlass 'flot=
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From here we understand that the information stored in the variable named
test variable is 73.07 and its data type is float.

During programming there may be times when the data type of a variable needs
to be changed or specified. This can be done by casting. This is done using the
casting constructor function in Python

Three important type casting functions are mentioned below.
int()- creates mtegers from floats or strings.

float()- creates fractional numbers from strings, [loats or integers.
str()-creates strings from different data types.

Now consider the following examples

w=inilt #Fihevalueof xwillbe | [x=floatil} # the value of xowill be 1O =g "s1") = the value of x will be sl
¥ =intd. &) # the vaine of y will be 2 | y= floan 2.8} # the value of y will be 2.5 y=strid) #the valve of y will be 2
z=nt"3" ) o the value of y willbe 3 [z~ Joat"3"y @ the valus of z will ke 3.0 £ = 53,00 % the valus of £ will be ‘3.0

= Flesat) "4, 2" # the vaine of w wrill be 4,2

Taking Data Input in a Program
If we want to take daia input from the user in a program, how do we do it? This
task is very easy using the input() function. When the program execution reaches
the input() function, it pauses execution and waits for the user to provide input.
Once the user enters some mput, the program resumes. For example, if we write
the following:

test_input=input ()
So. the test input variable will receive an input from us. However, no matter
what type of data number, letter, etc. the input() function accepts as input within
the program, it will receive it as a string (str) data type. Now, let's take an inpul
into a variable and print it.

tesl input= inpui()
print{test_input)
print{type(test_input))
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What will be the output of this program, then? Whatever you input will be print-
ed as the output, However, notice that even if you inpul an integer or a [raction,
its data type is printed as str. This means that any data you enter will be received
as a string by the input() function. But if yvou want the input to be stored not as a
string, but as an integer or a float data type, you’ll need to convert the data to that
specific data type. By writing the program as shown below, when talang any
mput, we can directly convert it Lo the desired data type in the input() function-

test input = inifinput(])

print{test_imput)

prini{typetest input))

After running the program, notice that due to writing int(inpui(})), the test_input
variable is being converted to the int data type.

Also, if we want, we can give a specific comment or instruction when taking an
input. To do this, we can write the command inside the input() function within
quotation marks. For example. if we write:

test mput = intput { Provide a sentence as an mput:')
prini(test_input)
print(type(test_input))

Then, after running the program, it will first display an input command for us.
Provide a sentence as an input:

Now, il we want, we can print additional words or sentences before and aflter
printing the information we input. To do this, we will write the words or sentenc-
es we want to print inside the print() function within quotation marks, and then
we will write the name of our variable after a comma. For example:

test input=int(input('Insert an integer number:'))
print("This 1s your integer number:', test input)

Then, we will see the output as shown below:
Insert an integer number: 1245

This is your integer number: 1234

Here, notice that when we print text inside the pruit() function, we write it within
single quotes (' ). However, when we print a variable, we write the name of the

variable directly without any quotes.
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Arithmetic Operations
We can easily use the following operators to perform mathematical operations
(addition, subtraction, multiplication, division, and modulus):

* | This is the Addition operator. Using this operator, you can calculate
the sum of the two variables on either side of it

B This is the Subtraction operator. Using this operator, you can find
the difference between the two variables on either side of it

ES

This is the Multiplication operator. Using this operator, you can
calculate the product of the two variables on either side of it.

/ This 1s the Division operator. Using this operator, vou can divide the
variable on the left side by the variable on the right side to get the
quotient.
This is the Modulo operator. Using this operator, you can divide the
variable on the left side by the variable on the right side to get the
remainder.

Practical Problem # 1: Let's create a program to take two numbers as input
and print their sum.

Solution: The program to take two integers as input and print their sum is given
below-

numl = int(input('Insert the first integer:'))
mumZ2 = int(input('Insert the second integer:"))
result = num1-+num?2

print("The sum of', num1,'and'. num2, "is'. result)

When you run the above program, you can input any two numbers of your choice,
and then it will calculate the sum of those numbers, displaying the result as shown
below.

Insert the first integer: 50

Insert the second integer: 100

The sum of 50 and 100 is 150

Modify the above program to create a program that prints the results of subtrac-
tion and multiphcation as well.
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Operators for comparison and their use:

Relation operator Example Use
== Opil==10 When the operand on the right and the operand on
{Eaqual) Opi== (Op2 + Op3} |the lefi are equal.
I= Opt =10 When the operand on the right and the operand on
(Mot Equal) Op1 I= (Op2 - Op3) | the |eft are not equal.
= Opl1=10 i F |
(Less Than) Op'< (Op2 - 10) For creating expressions '|.I'|'T|‘_]_'l__l‘ﬂl.l|tlpie u;.:era nds. -
== Opl==10 When the operand on the left is less than or equal 1o
{Less or Equal Op1l<=(Op2-Op3) the oparand on the right.
= Hp‘r}‘l& When the operand on the left is greater than the
{Greater Than) Opi= (Op2 + Cp3) operand on the right.
= Opt1==10 When the operand on the left is greater than or equal

(Greater or equal) | Op1>={+0p2+0p3) | g the operand on the right.

Here, Opl, Op2, Op3, are any valid variables. Relational expressions are formed
with one or more variables or arithmetic expressions vsing relational operators.

Using Conditions in the Program

We will create a program to calculate the results of an exam. Let's say the pass-
ing score for the exam is 40. Anyone scoring less than 40 will fail, while anyone
scoring 40 or above will pass. Therefore, a condition must be considered, and
passing or failing depends on that condition,

In Python, the if statement 1s used fo execute a certain action or statement based
on a condition, The use of the il statement can be compared to the meaning of
"if." The format for using the if statement is as follows:

ifcondition: = If statements
statement(s) to be -e_;a'cui:&& if
stotement fust be ow Iif x

The condition used in the if statement can generally be one
or more logical or relational expressions, which are writ- ¥ Tae
ten after the if. The if condition statement must be E?h;;}:"
followed by a colon. : J
If the value of this condition 1s true, the tasks described on
the line following the 1 will be executed.

This part is also called the body of the if. Any valid simple or compound state-
ment can be present here.
1l the condition is false, the control will not go to the body of the if. As a result,
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the tasks described in the body will not be executed, and the subsequent state-
ments will be processed instead.

Practical Problem #2:

The minimum passing scorg in an exam 1s 40. If a student scores 40 or more in
the exam, they will pass; otherwise, they will fail. Write a Python program to
determine the passing or failing status of a student based on the score obtained
as input.

Solution: Below is the code for the program.

mark = int(input(’'Flease enter your mark: 1)
if mark >= 40

print{'¥You have passed')
if mark < 40:

print{'¥ou have falled')

Sample results obtained by running the program:

Pleaze enter yvour mark: 83
You have passed in the subject,

if...else Statement

In Python, the if statement is used Lo execute a specitic action or statement based
on a condition. The else statement, meaning "otherwise." is used along with if to
specify an alternative action when the condition is not met. Therefore. this strue-
ture is known as the if...else statement. The format for using the if...else state-
ment is as follows:

5 Comiticn: | Boayorie_

e -_-H: ‘_'_J Body of else

Here it is mentionable that the condition vused in if...else control typically
consists of one or more logical or relational expressions. A colon is placed alier
the if Condition statement.

If the condition is true, the tasks specified in the
Body of if are executed. If it is false, the tasks in
the Body of else are executed. Here, any valid
simple or compound statement can be used. The
flowchart of the if...else statement 15 shown m the
diagram.

Forma=17. ICT={%-10)
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Practical Problem #3: Create a Python program that checks if a citizen is
eligible to vote based on their age.

Solution: In Bangladesh, any citizen who is 18 years old or older is considered
eligible to vote. The program will take the citizen's age as input. The code for the
program is provided below,

age = int{input|'FPlease enter your age: "))
if age = 18;:

print {'¥ou are eligible for wvoting')
alsa :

print{'¥ocu are not eligibkle for wvorting')

Practical Problem #4: Write a Python program to determine if a number is
even or odd.
Solution: The code for the program is given below.
num = int{inpot{'Insert a numbsr= "))
num$2 1= 0:

print{'The number 1is odd’)
eles :

print{' The number is even')

Sample Output [rom Running the Program:

Ingert a pumber = 67
The number is add

Practical Problem #35: Write a program to determine whether a given year is a
leap year or not.

Solution: To know if a year 1s a leap year, we need to divide the year number by
400. If the remainder 1s zero, il is a leap year. Otherwise, the year number has o
be divided by 100. If the remainder is zero, it is not a leap vear. On the other
hand, 1f the remainder is not zero, then we need to divide the year number by 4
again. If the remainder 1s zero, then the year is a leap vear; otherwise, it 1s not.
year = inc{inpoc|'Enter che vear {4 Digit) to check ")}

if (yveartd00 == 0 eor (year¥l00 != 0 and wyear $1 =— 0)):

print (vear, 'is & leap year.')
else :

print ivear, 'is not a leap year.')
The sample results obtained by munning the program-
Enter the year (4 Digil) to check 12012
2012 i3 3 leap vear.

Enter the year {4 Digit) to check :1990
1999 15 not a Ieap yeoar,
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Practical Problem #6: Write a program to convert metres to feet and feet to
melres.

Solution; The code for the program is given below.

print('l:Fast to Meters, 2:Meters to Feet.')
chaoice = ink(inpet ('Enter Chaice: ')
if cholce ==
num = fleatiinpuf{'Enter number of fest: "))
print{'Meters: ', roundi(num/3.28},3))
else
nuem = flaoat(input {'Enter number of meters: ')}
print {"Feet: ', round( (num*3.28),3))

The sample results obtained by running the program-

1:Feetto Maters. 2:hdeters to =Fest. Enter Choice:1
Enler mumber of feel: 25
Meterg: 7622

|:Feet to Meters, 2:Meters to Fect,
Enter Choice: 2

Eater number of heters: 60

Feet ; 156.300

To check multiple conditions in a Python program, the ehif statement 1s used
alongside the if...else statement, meaning else if. The elil statement is placed
between the if and else statements. The elif statement is popular as an alternative
to using multiple if statements in a program. In other words, elif 15 used to check
multiple conditions in a program. The format for using the elif statement is as
follows:

if (Conditional}):

Block:

elif (Conditionald):
Bloeks

else :
DefeultBlack;

Blockh;

Practical Problem #7: Write a Python program to determine if a given
number is positive, negative, or zero.
Solution: The code for the program is provided below.
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num = int(input|'Tnzert 2 number: "))

=

i1f num > O:

print('The nurmkber 1s posiclive’)
elif pum < O

print ('The number iz negative')
elas :

print {'Tt 1z zara')

The sample result obtained by running the program-

[n=ert & momber ; 7
The number is posinive,

The match Statement

In Python programming, the match statement is used for similar work of elif
statement 1.e. to execute a particular statement from multiple statements. In fact.
instead of using more number of elif statements, the match statement is used.
Additional case and break statements can be used with the match statement. In
an elif statement, the appropnate statement 13 selected based on a conditional or
relational expression. But, in a match statement, the appropriate statement is
usually selected based on the value of a valid varnable. The format of the match
statement 1s:

match MatghExp:
case Valuel 3
Bleckl
case Value? ;
Blocek2
case Valued :
Blockd
case _
DafaultBlack
BlockW

Here, the expression used with the match statement is called match expression
matchExp. In the case statement, possible values for the match expression mat-
chExp variable are provided. There should be at least one space between the case
keyword and the possible values of the match expression variable, and it ends
with a colon. A case statement usually has a default statement at the end, which
ends with a colon,

Practical Problem #8: Write a program to determine whether a lowercase
English letter is a vowel or a consonant.

Solution: A lowercase English letter will be typed as input. The code for the
program 1s given below.
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char = input|'Enter the lekttar:z ')
mateh char:s

case "g" :

printfchar, * ls a vowal )

case "=" &
printi{char, ' is a vowal "}
case "1" 1

print {char, iz & vow=l ')
cage "o" @
printichar; is & vowel ")
casa "u" :
prirntichar, " 15 a vowel ')
case

print{chary ' ia a conscnants')

The sample results obtained by running the program-

Enter the letter: a

ais a vowel

Enter the letter: d

d s a consonants

Solution with Alternative Method : The program above will show results only
if a lowercase English letter is typed as mput. The following program will
display results even when any English letter, whether lowercase or uppercase, is
typed. The code for this program is provided below.

ohar = input("Enter the letter: ')

srowelg o Prate ety N Taty Tate MRR TERG VTR TOYL IR
1f char in vowels:
print(echar, " if & vowel')
else :
printichar; ' i3 & conscnants')

Practical Problem #9: Write a program to find the largest number among three
mtegers,
Solution: The code for the program is given below.,

numl = int (inpdc{'Enter integer number 1: ')
numz = int (input('Enter integer number 2: "))
nuid = int (input{'Enter lnteger number 3: ')

if (numl = nnum?) and (nuaml >= fnum3) g
pelat (huml, '"ls the lafgest numbee')
alif (numZ >= numl) and (numd >= numd)
print (numd, 'is the larpgest number')
else :

print(numi, 'is the Ilargest oumber') -
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The sample result obtained by running the program-

Enter integer numbar 1+ 10

Enter integer number £: .20

Entar integer numbaer 33 30

30 is the largest numbar.

Repeating the Same Task: Using Loops in Programming

As we repeat certain tasks in our daily lives, we also need to perform some tasks
multiple times in programming. When we want to repeat the same task several
times In a program. we have to use a loop. In programming, loop control state-
ments are used o execute a statement two or more times. Some of the main loop
control statements used in Python programming are:

= for statement

= while statement

= continue, break and pass statement.,

Various statements are discussed below-

In a Python program, for statement is used to execute a statement two or more
times. The for loop is suitable only when we know how many times the loop will
be executed. Usually, he number of iterations of a for loop is calculated using a
variable. This type of variable is called counter variable. Following is the format
of for statement:

for CounterTrltlalizaedlon In Tondlitlon =

Jf Gtatementisl

In the Counter Initialization section, the initial value of the counter variable is
set. This is called the initialization or the beginning of the loop. In the Condi-
tion section, the final value of the counter variable or the condition for deter-
mining the final value is given, Statements associated with the for loop contin-
ue to be executed until the counter variable reaches its final value or as long as
the condition is true.

Practical Problem #10: Write a program to display a specific text multiple
times.

Solution: Let's say, the text ‘ICT" will be displayed 5 times.
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for | in range{l,&):
peint{"ICT!)
Solution with Alternative Method 1; (tnoremens by 1)
for { in range{l,&6,1):
print {TICT™)
Solution with Altemmative Method 2: icecrensnt by 1)
for | in ranga(l,&,-1):
print {'ICT")
The sample results obtained by running the program-
ICT
ICT
ECT
ICT
ICT

Practical Problem #11: Write a program that will display a word 50 times.
Solution: The code for the program is given below.
var = input{'Write a word: ')}
for | in range(1,31):
print {varc)
The sample result obtained by running the program-

Wiite a word: Computer
Compuler Compuiter Camputer Computer Campuler
Computer Computer Computer Computar Computer

Computer Computer Computer Computer Computer
Compular Complitar Camputer Complter Computer

Practical Problem # 12: Write a programme to find the odd numbers from | to
100.
Solution: The code of the programme is given below-

for 1 in range(l,101}:
if [1%2 =0}
peint (1)
Running the programme will show the following result.

135791113 15 17 19 21 23 25 27 29 31 33 35 37 39 41 43 45 47 49 51 53 55 57 58
61 63 65 67 69 71 73 75 77 79 B1 B3 BS BY B9 91 83 95 97 99
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Practical Problem # 13: Write a programme which will show the following
result.

12345678%

Solution: The code of the programme is given below-

for | in ranga(l, 10}):
for i in range(l, 1 + 1):
print{j., end=" "}
priok (f

Running the programme will show the following result.

=
L

[ T I B S
A L

=
[
=

I
I
1
]2
1
23
1234567
12345678

123456789

Practical Problem # 14: Write a programme to determine the denominator or
multiplication table of a number.
Solution: The code of the programme 1s given below-

nam = ink (anput('Enker a number: "))
Eor i in range(l,11l):

prod = num*i

print foum,. "A0c 40 Y= prad)

Running the programme and inputting the following sample data will show the
result-
Enter n number: 3

3*1=3
A%1=h
3*3=0
3*4=12
3*5=15
I*p=18
a7=21
3*8=24
3*8=37
3*10=30
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A for loop statement may contain some other
for statements. This type of for loop 1s called
nested for loop, the intermediate [or loop 1s {
called inner for loop and the external for loop
is outer for loop. The inner for loop completes

before the outer for loop.

Is
condition
trie?

| da "//
something

While Loop

137
—for (.. . . )
for (. J—
{
Block1;
} < e for Lo
Block?;
m— < cmer b Locp
Block3;

Tha condition 5 verified
atthe beginning of the

nditlon given in the
hile Jonp is trus.

A While Loop statement is used in Python programmes to execute a statement
two or more times subject to a condition. The condition is verified at the begin-
ning of this loop. The loop will only be executed if the given condifion is true or
non-zero. Otherwise, the loop will terminate, and no statement will be executed.
The format of While Loop control 1s as follows:

Counterinitialization;
while Conditicn:

J/ Statemant (5)
CounterbDecrament/ Increment;

Forma-18, TCT=(%-10)
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1  The counter initial value with the appropriate
- ] data type is set in the Counterlnitialization
v
while (conditien): part. _
The final value of the counter variable or the
condition to determine the final value is

il I given in the Condition part. the decre-
v ment/increment value of the counter variable
— Stop 1s defined while revolving each time in the

| decrement/increment part. Statements asso-
ciated with the While Loop will continue to
be executed until the condition is true. The loop terminates whenever the
condition becomes false.
The statement associated with the While Loop is usually a compound
statement. If necessary, another While Loop or for loop can be used within
a While Loop. Such an intermediate while loop is called a nested while
loop.

—>»while (... ... ...)
{

w?ite Cae sow )™=
|_> Elc-ck'i

if Cnndltmn} FANeE White: Laop
break;

B!Uckz Cuter while Loag

EEG{:kS ]

Flowchart of nested a while statement.

While Loops are often used as alternatives to for statements. The number of
iterations of the while statement i1s calculated using any previously declared
counter variables like the for statement.

Practical Problem #15: Write a programme to display the text ICT multiple
times using a while loop.

Solution: Let's say the text ICT will be displayed 3 times.
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count=1

while (count<=3);:
print ('ICT")
count=count+l

The result after running the programme —

T
ICT
ICT

Practical Problem # 16; Write a programme to find the sum of the series

| fy 2 - o OOt +100. Or, write a programme to find the sum of all positive numbers from
1 to 100.

Solution: The code of the programme is given below

sum="{

count=1

while [count<=109):
sum = sum + count
count=gount+]

print{'The sum of the wvalue i1 ', sum)
Running the programmenre will show the following result-
The suwm of the value 15 3050

Continue Statement
In Python programmes, a continue statement is used to conditionally or uncondi-
tionally repeat a statement or loop. The format of the continue statement is-

continue

The continue statement moves the programme pointer to the previous statement
or to the beginning of the loop. The continue statement cannot work directly
without if; elif, for, while eic. For this reason, the continue statement is usually
used to repeat a loop subject to the condition related to if, elif statements. In that
case the conitnue statement is executed if the value of the condition is true.
otherwise the compiler ignores the continue statement and executes the next
statement.

A programme to omit any number from 1 to 10 eu,1§i display the remaining num-
bers using the continue statement is given in the next page-
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Solution: Let’s say, the omifted number is 4. The programme is given below-

for num in rangafl, 11, 1):
if num == §:
continoe
alse:
print (num, end=" ")

princi{'Used continue Lo skip printing the value 4°})
Runnming the programmeme will show the following result-

123578910

Used continue to skip printing the vakue 4

Break Statement

If a break statement is found in the loop of Python programmes, the loop finishes
its task there and comes out of the loop. Like a running vehicle that halts when
its brakes are applied, the loop execution stops when a break statement is found
in the loop. In most cases, the break statement is used with if, elif, efc.

Exercise:

The function of Interpreter is

1)To transform every command into machine language all at a time
i1)To transform commands into machine language one by one

iii) To transform machine code into Python code

Which of the following is true?
A)iand i B) i and iii
C) i1 and iii D) i, ii and iii

[

Which function is used in Python to show a text on the screen?
A) print{{) C) prnt
B) print() D) println()
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L]

Which of the following is the correct name of a variable in Python language?
A) 9abc C) print
B) $variable D) National ID

In Python language, if y = int(2.8), what is the value of print (v)?
A) 2.8 B)2
C)28 D) 2.0

If in Python language a=5, b=2, y=a"b, what is the value of print (y)?
A)l D)2
C)3 C)5

Notice the following Python code:
for i1 in rangai(l, E}:
print [ "ICT')

. Here, how many times the word ICT will be displayed?

A)1 B)5
C)3 D)6

What is machine code? Write how programme code can be transformed
into machine code.

What 1s Casting Constructor Function? Write the name of some functions.
Write two programmes to determine the sum of all positive numbers from

1 to 100 using for loop and while loop. Analyze which programme is conve-
nient.

10. Explain break and continue statements.

The End
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